
 

   
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



   

 

 

   

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Legal Notices 
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Intro 
 
 
 
MixPre-10T をお買い上げいただきありがとうございます。 我々はオーディオに情熱を持つプロダク
トメーカーです。 我々はデザインとエンジニアチーム（そのほとんどがミュージシャンである）に呼
びかけ、我々自身が欲しくなるようなデバイスを作らせました。 お客様には、その独特なミックス・
パフォーマンス、使いやすさ、そしてこれからの長年に渡ってあなたの創造性豊かな熱意とあなたの
かけがえのない作品を生みだす品質を MixPre-10T に感じ取ってもらえれば幸いです。 
 
MixPre-10T は、柔軟性と音質と、３つのベーシックな操作系統を提供すべく細心の工夫により設計さ
れています。 
 
⚫ 10 入力（8 mic/line XLR/TRS 入力 + 2ch Aux 入力）、4-channel 出力ミキサーと登録商標の

Kashimir™ディスクリートマイクプリアンプ、ユーザー・セレクト可能なアナログ・リミッター
とローカット・フィルター。 
 

⚫ 44.1, 48, 96, 192kHz、16, 24-bit 解像度で 12 チャンネル（Ch 1-8 と Aux in ISO トラックと
LR ミックス）を SD カードに録音。 
 

⚫ 12-in, 4-out USB コンピュータオーディオ・インターフェース 
 
 
MixPre-10T の運用の可能性は実質的に限界がありませんが、いくつかの用途を上げると… 
 
⚫ ビデオプロダクション用のロケーション・サウンド・レコーディング 

 
⚫ 効果音を捕えるためのフィールド・レコーディング 

 
⚫ DAW アプリケーション用のプレミアム品質の 12x4 USB オーディオインターフェース 

 
MixPre-10T の電源ソースはさまざまなタイプから選べるので使用用途にさらなる柔軟性を提供します。 
単三型電池、リチウムイオン充電池、壁コンセントからの AC アダプターによる電源供給が可能なので、
いつでも、どこでも、常にあなたがオーディオを取り扱いたい時に MixPre-10T を御利用いただけま
す。 
 
MixPre-10T は、プロ・オーディオ機材で必要とされるプロフェッショナル・レベルの機能を省略する
ことなく、初心者にも簡単に使えるように設計されています。 そのコンセプトから、工場出荷時の
MixPre-10T はベーシックモードに設定されており、これはプロ・オーディオ機材に未経験なユーザー
向けでありながら、ほとんどのオーディオ・アプリケーションで満足できる設定でもあります。もし、
プロフェッショナルなフル機能をすぐに御利用になりたい場合、アドバンスモードに設定することを
お勧めします。モードを切替える方法はこのマニュアルに後述されています。 
 
お客様のオーディオ編集作業が MixPre-10T によってより豊かになることを我々は切に願っております。
MixPre-10T を御利用いただいたお客様の御感想をお聞かせいただけると非常にうれしく思いますので、
support@sounddevice.com までご投稿いただけると幸いです。 
 
 

mailto:support@sounddevice.com
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Powering 
 
 
 

Flexible Powering Options 
 
MixPre-10T の設計段階で、我々はさまざまなアプリケーションや使用環境で運用する事ができる製品
であることが非常に重要であると感じました。 これを実現するために、いくつかの電源ソースを選択
していただける仕様となっています。電源ソースを選択する例として以下があります。 
 
⚫ AC パワーサプライ(XL-WPH3)から 4-pin ヒロセコネクターへ 12VDC 給電 
⚫ 8 本の単三型アルカリ、または NiMH 充電電池を装着したバッテリースレッド（MX-8AA） 
⚫ 1 個か 2 個の Sony タイプ L-mount バッテリーを装着した バッテリースレッド（MX-LMount） 
 
MixPre-10T の電源スイッチは、左側面の右上に位置しています。 
 
 
 
 
 
 
 
 
 
 
 
 
 
MixPre-10T に装着されたバッテリー放電を抑えるため、4-pin ヒロセの電源ソースとバッテリーが両
方とも接続されている場合は、ヒロセ電源の優先的に使用されます。 
 
 
バッテリーの正確なレベルを確認するには： 
 
1.      をタップします。 

 
2. サブメニューにある Power をタップします。 
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3. 次のいずれかを操作します。 
 
➢ Battery Sled をタップし、スレッドに使用されているバッテリー・タイプを選択します。 

オプション： MiMH, Alkaline, L-Mount 
 

➢ Ext Power をタップし、使用されているバッテリータイプを選択します。 
オプション： 12V Ext DC, NiMH, Exp. NiMH, 12V PbAcid, 14V Li-ion, Full Range(10-17V) 

 
 
補足：Ext Power の設定 
 
MixPre-10T の Menu 階層にある Ext Power 設定には６つのオプションがあります。 
以下の表は 688 の資料から引用した資料です。 
 
 
 
 
 
 
 
 
 
 

Info: MixPre でバッテリーを使用する時、推奨される単三型は、NiMH 充電電池か、リチウム
一次電池です。アルカリ単三電池は推奨されません。アルカリ電池の高い内部抵抗は、
低消費電流（25mA 以下）の製品に向いていますが、MixPre のような大電流を必要と
する機材には向いていません。 

 
 

Info: 間違った電池の使用は爆発の危険があります。同じか同等のタイプに交換してくださ
い。 交換後の電池は正しく廃棄またはリサイクルしてください。 電池をクラッシュ、
分解、焼却したり、高温の場所や火中に電池を投じないでください。 
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Panels 
 
 
 

Front Panel 
 
Power ライト、レコーダーのトランスポート用ジョイスティック、スター（＊）トグルスイッチ、チャ
ンネルノブ、チャンネルノブ・リング LED、タッチ画面 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Left Side Panel 
 
LTC/Word Clock 用 BNC 出力、LTC/Word Clock 用 BNC 入力、USB 接続、XLR コンボソケット（1/4
インチ TRS）入力、X1/X2 アンバランス出力(3.5mm)、パワースイッチ 
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Right Side Panel 
 
3.5mmヘッドフォン出力ジャック、3.5mm Mic/Aux入力、XLR コンボソケット（1/4インチTRS）、
ヘッドフォン・エンコーダー、HDMI TC 入力 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Back Panel 
 
バッテリーマウント、4-pin ヒロセ電源コネクター、SD メモリーカードスロット、六角（アレン）レ
ンチ（1/4 インチ 20 スレッド用）、回転防止固定ピン 
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Touch Screen 
 
 
MixPre-10T は、日光下でも見やすい高解像度のタッチパネル内蔵ディスプレイを搭載しています。タ
ッチディスプレイは、Home 画面、Main Menu 画面、Channel スクリーンビューから構成されていま
す。 タッチディスプレイは、コントロール用にいくつかのタッチ領域があります。 ユーザーインタ
ーフェースとして親しみやすいタッチディスプレイの採用により、インプット、アウトプット、レコ
ーディング、メータリングにすばやく直観的にアクセスすることができます。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Home Screen 
 
Home 画面ビューは、デバイスの電源投入後のタッチスクリーンに表示されるデフォルト・ビューで
す。 この画面には次の情報が表示されます。 
 
⚫ File list アイコンと現在のファイルネーム 
⚫ 録音／再生の経過時間カウンター（LTC か HDMI タイムコードが有効の場合は timecode） 
⚫ 電源ステータスアイコン 
 

電源ステータスアイコン 詳細 

 

 

（緑色・USB） 

ヒロセコネクターに接続された外部電源ソースは良好。 

 

 

（緑色・バッテリー） 

良好なバッテリー。 ゲージが 1/4 まで落ちたらバッテリー交換を推奨。 

 

 

（赤点滅・バッテリー） 

バッテリー残量がありません。すぐにバッテリー交換を推奨。 

 
 
⚫ Menu アイコン 
⚫ Meter ビュー（タッチ操作により画面をサイクル表示） 

 ２つのミックストラック・メーター 
 ２つのミックストラック、10 の個々のトラックメーター 
 ２つのミックストラック、２つの USB 入力メーター、２つの aux 入力（カメラ）メーター 
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➢ ステータス・バー 

 SD カードのステータス：カードアクティビティ、録音残時間、ファイルの時間、経過時間、
ヘッドフォンプリセット 

 USB ドライブステータス：コピー機能が有効な時、ドライブの残量 
 サンプルレートとビット深度 
 日付と時刻 

 
 

Main Menu Screen 
 
Menu 画面は、ほとんどの機能、選択された機能、セットアップがあります。 
 
Menu 画面に入るには： 
 
➢ Home 画面で      をタップします。 
 
３つの Menu 画面ビューがあります。 これらのビューは、ドットアイコン            によって表示
されます。 これをタップして、３つの Menu 画面ビューを切替えることができます。 
 
 
 
 
 
 
 
 
 
 
 
 
Menu 内のそれぞれのオプションをタップすると、サブメニューが表示されます。 
 
サブメニューからメイン Menu へ戻るには： 
 
➢       をタップします。 
 
 
メイン Menu から Home 画面に直接戻るには： 
 
➢    をタップします。 
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ページ サブメニュー 詳細 

1 Presets SD カードと内部メモリーへ、ユーザー設定のセーブとリコール。 ファクトリー

デフォルトによる全設定のリセット。 

1 Project 新規作成、既存プロジェクトのオープンと削除。 

1 Inputs Aux / Plug-in-power Mic / Timecode input / Camera の設定。Ch-9,10 のチ

ャンネル・スクリーンへのアクセス。 

1 Outpus * ステレオ出力用のルーティングとゲイン設定。 

2 Timecode タイムコードモードの選択。 

2 Tone/Slate スレートマイクレベルとテスト・トーン信号の設定。 

2 Record ** LR ミックスゲイン、サンプルレート、ビット深度、LR インク、HDMI レコード・

トリガーの録音設定。 

2 SD Card 挿入されている SD カードの情報、フォーマット、カードを空にする機能。 

3 USB Drive USB サムドライブの情報の表示、ドライブのフォーマット。 

3 *Shortcuts さまざまなファンクションをフロントパネルの＊／＊＊トグルスイッチに割り

当て。 

3 System Basic/Advanced/Custom モード、リミッター、USB-C、ファイル転送、

Bluetooth、Wingman App パスワード、LCD/LED 輝度、ファームウェアアッ

プデート、現在のバージョン。 

3 Power 使用しているバッテリー（アルカリ、NiMH、L-Mount）の種類。 ここの設定で、

Home 画面のパワーステータスアイコンでバッテリー残量が正しく表示されま

す。 

＊サブメニュー／設定は Advanced モードだけに表示されます。 

**Record サブメニューオプションの一部は Advanced モードだけに表示されます。 

 
 
 

Channel Screen 
 
チャンネル画面は、チャンネルネーム、入力選択、パンニング、48v ファンタム電源、低域カットフ
ィルター などの特定のチャンネル設定を確認、設定することができます。 
 
 
 
 
 
 
 
 
 
 
 
 
Advanced モードでは、ドット・アイコンをタップすることで２頁目のチャンネル画面にアクセスして、
さらに詳細な設定を行うことができます。 
 

Info: チャンネル画面の左上コーナーには編集可能なチャンネルネームが表示されます。この
部位にタッチして、Vocals や Bob といった判別しやすいチャンネルネームに変更でき
ます。チャンネルネームの下はオーディオレベル設定の参考になるチャンネルメーター
です。 
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ページ サブメニュー 詳細 

1  Solo* 選択されたチャンネル音がヘッドフォンに出力されます。 デフォルトのソロは、

個々のチャンネルを排他的に選択され、一度に１つの入力だけソロになります。

ソロになると、ライト・リングがオレンジに点灯します。 HP プリセットのサブ

メニューの中で Multiple（非排他）に設定することができます。 

1  Arm* チャンネルごとの独立した(ISO)トラックを SD カードにプリ・フェーダー録音

できます。 

1  Gain* 入力の感度を設定します。一般的に、音が一番大きな時にメーターの赤い部分に

達するくらいにゲインを設定します。 

1 Pan LR ミックスとステレオ出力のチャンネルのステレオイメージの中で、インプッ

トチャンネルの位置を定めます。 

2  Input 選択可能な Mic, Line, USB のいずれかを選択された入力チャンネルに設定しま

す。 

2  Phantom チャンネルの mic または line 入力に 48v ファンタム電圧を給電します。 

2  Low Cut ハイパスフィルター（HPF）とも呼ばれる Low Cut フィルターは、マイクを持

つハンドリング雑音、カプセルに受ける風雑音、不要な低域成分を抑えます。 フ

ィルターは 18 dB/oct スロープです。 

2  Phase* 信号の位相を 180 度反転させます。 

3  Delay* シグナルパスの中にディレイを入れます。 複数のマイクロフォンにおける位相

や、ビデオ用にリップシンクの調整に用いられます。 

3  Linking* 2 と／か ４チャンネルのリンク。詳細は Linking Channel を参照。 

＊サブメニュー／設定は Advanced モードだけに表示されます。 

 
 
チャンネル画面に入るには： 
 
➢ 任意のチャンネル・ノブを押します。 
 

Info: Ch 9,10 のチャンネル画面に入るには、 Menu > Inputs からアクセスするか、Ch 
9/10 Screen に設定されたスタートグルスイッチ(＊/＊＊)を操作します。 

 
 

Using Star Shortcuts(*/**) 
 
MixPre-10T にはユーザープログラム可能な Star(＊)と呼ばれるトグルスイッチがあり、２つのスイッ
チ位置 *と**に設定された機能にすばやくアクセスすることができます。 
 
スタートグルスイッチに機能を設定するには： 
 
1.    をタップします。 

 
2. ＊Shortcuts > *Shortcut (か**Shortcut) を選択します。 

 
3. 表示された＊Menu 画面で、任意の機能を割り当てます。 

 
・Ch 9/10 
・Solo/Mute 画面 
・Project 画面 
・SD カード画面 
・Undo 
・Slate Mic 
・Tone 
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Modes and Presets 
 
 
 

Setting the Mode 
 
MixPre-10T は、プロユーザー向けの本来のプロフェッショナルレベル機能を省略することなく、初
心者が簡単に使用できる設計になっています。 我々は、エントリーユーザーとプロフェッショナルユ
ーザーの両者に、簡単かつ素早い設定と確実な結果を手にしてもらうよう、MixPre-10T に３つのモー
ド（Basic, Advanced, Custom）を実装しました。 
 
モードを設定するには： 
 
1. すべてのチャンネル・ノブをオフにします。（反時計方向まわしきり） 

 
2.    をタップします。 

 
3. System > Mode をタップします。 オプションは以下です。 

Basic, Advanced, Custom 
 
 
 

Basic Mode 
 
Basic モードは、手間のかからない、プラグアンドプレイ使用を意図しています。 このモードはエン
トリーユーザーや MixPre-10T の基本機能だけを必要とするアマチュアに最適です。 
 
 

スクリーン サブメニュー 詳細 

Menu  Presets SD カードと内部メモリーへ、ユーザー設定のセーブとリコール。 ファク

トリーデフォルトによる全設定のリセット。 

Menu  Project 新規作成、既存プロジェクトのオープンと削除。 

Menu  Inputs 3.5mm Aux / Mic 入力の設定と、 Ch-9,10 のチャンネル・スクリーン

へのアクセス。 

Menu  Timecode Timecode と sync の設定。 

Menu  Tone/Slate Tone/slate mic の On/Off、トーンルーティング、スレートマイクのレ

ベルの設定。デフォルトで、Tone は 1kHz -20dBFS の sine 波。 デフォ

ルトで slate mic レベルは 25dB で、調整範囲は 0 – 50dB。 

Menu  Record カメラからの HDMI 経由、または LTC による自動 start/stop レコーディ

ング設定。 

Menu  SD Card 挿入されている SD カードの情報、フォーマット、カードを空にする機能。 

Menu ＊Shortcuts */**トグルスイッチにショートカットとして機能を割り当てます。 

Menu  System Basic/Advanced/Custom モード、リミッター、日付と時刻、ファイル

転送、Bluetooth、Wingman App パスワード、LCD/LED 輝度、ファー

ムウェアアップデート、現在のバージョン。 

Menu  Power 使用しているバッテリー（アルカリ、NiMH、L-Mount）の種類。 ここの

設定で、Home 画面のパワーステータスアイコンでバッテリー残量が正し

く表示されます。 

Menu  HP Preset ヘッドフォンソースの選択：LR ステレオ、X1X2 ステレオ、USB1,2、

USB3,4 
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スクリーン サブメニュー 詳細 

Channel  Pan LR ミックスとステレオ出力のチャンネルのステレオイメージの中で、L、

C、R にパンニングを設定します。 

Channel  Input チャンネルの入力タイプを、Mic、Line、Aux、USB から選択します。 

Channel  Phantom チャンネルにコンデンサー・マイクロフォンを使用するときに、48V フ

ァンタム電源をオンにします。 

Channel  Low Cut ローカット・フィルターを使用する場合に周波数を選択します。 このフ

ィルターは 18 dB/oct のスロープカーブです。 Basic モードでは、フィ

ルターは On / Off 設定です。 

 
 
 

Advanced Mode 
 
アドバンスド・モードは、プロフェッショナル・ユース向けのモードです。使用用途や環境に合わせ
たより細かなオーディオ設定が求められる場合に使用します。 Basic モードで有効なすべての設定は、
Advanced モードにも適用されます。 
 

スクリーン サブメニュー 詳細 

Menu  Output Stereo Out と X1/X2 用のルーティング、ディレイ、ゲイン設定と output

ディレイ設定です。 

Menu  Tone On/Off だけでなく、Coutinuous（連続）と Left Identify（左のみ不連

続）、トーンレベルの設定が加わります。 

Menu  Record ゲイン、サンプルレート、ビット深度、LR リンク 機能が加わります。 

Menu  HP Preset LR Mono、User Presets 1-4、Edit HP Preset ユーティリティ、HP Solo

モード選択。 Aux In モードが Camera に設定されると、Camera Stereo

と Camera Mono 設定も加わります。 

Menu  System > 

Limiters 

リミッター機能の On / Off。 

Channel  Solo ヘッドフォン出力用にチャンネルを solo に設定できます。Solo モード

は、HP Preset メニューで Individual（個々）か Multiple（複数）を選択

できます。 

Channel  Arm チャンネルのプリ・フェードを個々のアイソレート・トラックへ録音する

設定です。 

Channel  Gain インプットの感度を設定します。 一般的に、音声の大きな時にレベルメ

ーターが赤いセグメントに届くくらいにゲインを設定します。 

Channel  Pan LR ミックスとステレオ出力のチャンネルのステレオイメージの中で、L

から R に無段階でパンニング位置を決めることができます。 

Channel  Linking Ch 1 と 2、3 と 4、5 と 6、7 と 8 のいずれかをステレオペアまたはミッ

ド・サイドペアとしてリンクできます。Ch 9 と 10 もステレオペアとし

てリンクできます。また、Ch1-4 と Ch5-8 とリンクもできます。 

Channel  Low Cut 低域カットフィルターが有効になる周波数を設定します。Advanced モー

ドで増えるオプション：Off、40-160Hz (40Hz ステップ) 

Channel  Phase 位相を、Normal か Inverse に設定。 

Channel  Delay ディレイ値を 0 – 30 ms に設定。（1ms ステップ） 
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Custom Mode 
 
カスタム・モードは、ユニットの特徴と機能性をカスタマイズしたいユーザーを対象にします。この
モードでは、Advanced モード機能の中からユーザーが任意に On/Off 設定した選りすぐったものをイ
ンターフェースに表示してアクセスできるようにするものです。 
 
 
カスタム・セットアップを設定するには： 
 
 
1.    をタップします。 

 
2. System > Mode をタップし、Custom を選択します。 

 
3. System > Custom Setup をタップして、任意の機能をカスタマイズします。 

 
 
カスタム・セットアップのオプションは以下です。 
 

ページ サブメニュー 詳細 

1  Channel ソロ、トラックアーム、拡張パン、入力セレクト、ファンタム、ディレイ、ロー

カット（周波数設定可）。 

1  Gain チャンネル・ゲイン（2 ステージ）、リミッターとリンキング。 

1  Headphone ヘッドフォン・ソース選択オプション。 ファクトリー、ユーザーHP プリセット、

プリセット編集、個々／マルチのチャンネル用のソロセットアップ。 

1 Record 録音に関する追加設定。ゲイン、サンプルレート、ビット深度、LR アーミング

とリンキング、ISO トラックアーミング／ネーミング。 

2  Metadata トラックネーム変更、ファイルのリネーム、ノート記述、録音アンドゥ。 

2  Outputs Stereo 出力用のルーティング、ゲイン、トーンモードとレベル。 
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User Presets 
 
柔軟性は MixPre-10T の特徴です。 さまざまな利用状況に即して簡単に MixPre-10T を使えるように、
MixPre-10T のすべての設定をストアし、それをリコールする機能がユーザープリセットです。 
MixPre-10T 本体に４つのインターナル・プリセットのスロットがあります。プリセットは SD カード
にも保存できるので、保存できるプリセット数は実質的に制限がありません。 
 
３つの一般的な使用例： 
 ある日、MixPre-10 をミキサーやレコーダーのようなプロダクション・オーディオ・リグの一部

として利用します。 
 次の日、MixPre-10 をコンピュータベースの編集セッション用の USB 接続のマルチチャンネルオ

ーディオインターフェースとして利用します。 
 土曜日の夜に、地元のオーケストラの演奏を録音するよう頼まれて、MixPre-10T を利用して８チ

ャンネルのマイクプリアンプで複数の楽器音や空間アンビエンス音を収録します。 
 
プリセットを使用して、これらの異なるシナリオに適したセッティングを、４つのインターナル・プ
リセットまたは SD カードへ簡単に保存することができます。一度セーブすれば、最適なプリセットを
簡単にロードしてすぐさまセッティングを呼び出せます。  
 
 
プリセットをセーブするには： 
 
 
1.    をタップします。 

 
2. Presets > Save to … とタップし、Internal 1-4 か SD カードを選びます。 

 
3. プリセットネームを入力して OK をタップします。 
 
 
 
プリセットをロードするには： 
 
1.    をタップします。 

 
2. Presets > Load Preset とタップします。 

 
3. エンコーダを操作して、プリセットを選択します。 

 
4. OK をタップします。 
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Inputs 
 
 
 
MixPre-10T の柔軟性は、ミキサーチャンネルへさまざまな入力タイプを選択できることにより拡張さ
れます。 MixPre-10T の各チャンネルの入力ソースは、XLR mic/line インプット、3.5mm Aux 入力
またはプラグイン・パワーMic インプットから、またはコンピュータからの USB チャンネル 1-4 のい
ずれかのチャンネル音声からアサインされます。 
 
 
 

Channel Inputs 
 
 
BASIC MODE - 
 
すばやく簡単にオーディオを扱う現場では、任意のチャンネルのチャンネル・ノブを押すことで、イ
ンプットセッティングにアクセスすることができます。 表示されるチャンネル・スクリーンは以下で
す。 
 
 
 
 
 
 
 
 
 
 
 
ここでは、チャンネルのインプット・ソースの選択、ミックスバスとステレオ出力への Left, Center, 
Right へ送る設定、ファンタム電源（コンデンサー・マイクロフォンとアクティブ DI 用）の設定、ロ
ーカット・フィルターの設定 があります。  
 
Basic モードでは、フロントパネルにあるチャンネル・ノブによってレベル調整される１つのゲイン・
ステージをインプット・チャンネルに持ちます。 
 
MixPre-10T の Kashimir™ マイクプリアンプは非常に広いダイナミックレンジ、ローノイズなオーデ
ィオ特性に加えてアナログ・リミッター機能が基本的に備わっているので、LR ミックス録音チャンネ
ルと LR 出力に送るためにチャンネル・ノブを調整してレベル調整する以外には細かな調整を必要とし
ません。 
 
リミッターは、各インプットチャンネルと LR ミックスバスにそれぞれ備わります。 リミッターを持
たないプリアンプではクリップしてしまってミックスの音質が損なわれるようなピーク信号であって
も、リミッター機能によって Stereo 出力やレコーダーに録音される音が歪んでしまうことを防ぐこと
ができます。 
 
  
ADVANCED MODE - 
 
アドバンスド・モードは、アイソレート・トラックへの録音、ソロ、チャンネルリンク、拡張ゲイン
設定、リミッターバイパス、などの複雑な設定が要求されるシチュエーション向けです。 
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CUSTOM MODE - 
 
Channel Custom 設定を Advanced に、Gain Custom 設定を Basic に設定することで、１つのゲイン
ステージをフロントパネル・ノブでコントロールしながらインプットチャンネルのパラメータを拡張
することができます。 そして、フロントパネル・ノブで調整されるレベルは ISO トラックへ送られま
す。 
 
チャンネルを設定するには： 
 
1. 任意のチャンネルのロータリー・ノブを押します。 
2. Input をタップし、つぎの入力タイプから選択します。 

 
 
 
 
 
 
 
 
 

3. ウィンドノイズやハンドリングノイズを軽減するために、必要に応じて、Low Cut をタップしてロ
ーカット・フィルターを設定します。 

4. Pan をタップして、ミックスバスや Stereo out へのパンニングを設定します。 
 
 

Linking Channels 
 
キーボードやステレオ・マイクのようなステレオソースを利用する場合、MixPre-10T のインプット 
1-2, 3-4, 5-6,7-8 のいずれかをステレオペアや MS(mid-side)ペアでリンクすると便利です。Ch 
9-10 もステレオペアとしてリンクすることができます。 次の例では、チャンネル 1 と2 をリンクする
手順を紹介します。 
 
 
Ch 1,2 をリンクするには： 
 
1. チャンネル画面に入るために Ch-1 のノブを押します。 

 
2. 画面のページ３で、Linking をタップします。 
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3. 次のいずれかを操作します。 
 
➢ ステレオソース用に 1-2 を選択します。 
➢ MS（ミッドアンドサイド）用に 1-2ms を選択します。 
 
設定されると、Ch1,2 の両方のチャンネルは、Ch-1 のノブでレベルコントロールできます。 Ch 2 の
ノブは、ステレオリンクされたときはバランス調整として、MS リンクされたときは width 調整として
機能します。 
 
MixPre-10T は、Channel 1-4 と 5-8 用の 4 チャンネルリンクを組むこともできます。 
 
 
マルチチャンネルリンクを組むには： 
 
1. System > Mode が Advanced に設定されていることを確認します。もし Custom モードを使用

しているなら、Channel が Advanced に設定されていることを確認します。 
 

2. Ch1-#（#には 3-8 が入ります）の場合は Channel-1 のノブを押します。5-7、5-8 の場合は、
Channel 5 のノブを押して、チャンネル画面にアクセスします。 
 

3. Linking をタップし、1-4 か 5-8 をそれぞれ選択します。 
 
マルチチャンネルリンクが組まれると、ゲイン、フェーダー、リミッター、トラックアーム、ロ
ーカットフィルター、インプットディレイ がすべてリンクされ、Ch-1（または Ch-5） の画面と
ノブからコントロールされます。 

 
また、Link Type メニューは、３つ以上のチャンネルがリンクされるとき、リンク動作するパラメータ
を設定することができます。 

・ Link Type で ”All” を選択すると、input type, trim, gains, faders, limiters, low cuts, record 
arms, delay の全オプションがリンクします。 

・ Link Type で ”Faders Only” を選択すると、フェーダーだけがリンクします。  
 

Gain Staging with Linking 
 
リンクを組む場合に、１つのゲインステージか２つのゲインステージ（trim/gain）のどちらかに設定
して操作することができます。 
 
例えば、インプットの 1-2 または 1-4 をリンクしたい時に、ゲインステージを１つ（フロントパネルの
Ch-1 ノブから全レベルコントロールを行う）にするには、System > Mode で Custom に設定し、
Custom Setup で Gain を Basic に、Custom Setup で Channel を Advanced にそれぞれ設定しま
す。 
 
上記と同じインプットをリンクしたい時に、チャンネルのゲインステージを２つに設定するには、Gain 
と Channel の両方を Advanced に設定するか、あるいは Custom Setup で Gain と Channel を両方
とも Advanced に設定します。これで、リンクされたチャンネルのゲインレベルが Ch-1 の画面から調
整され、リンクされたチャンネルのフェーダーレベルが Ch-1 ノブで調整できます。 
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Setting Input Delay 
 
インプット・ディレイは、たとえばブームマイクとワイヤレス・ラジオマイクが同じ音源を収音した
場合にそれぞれの音源からの到達時間の違いによる位相ズレのオーディオを補償するために用いるこ
とがあります。 
 
チャンネルのインプットディレイを設定するには： 
 
1. チャンネルノブを押して相当するチャンネル画面にアクセスします。 

 
2. ページ３にある Delay をタップします。 

 
3. 画面の矢印をタップするか、エンコーダを操作して設定します。 各チャンネルで最高 30ms まで

ディレイをかけられます。 
 
ディレイの効果は、レコーダーや出力へ送られる前に適用されます。 
 

Info: インプットディレイは Basic モードでは無効です。 
 
 
 

Inverting Phase 
 
位相反転（または極性反転）は、間違って配線されたバランスケーブル、反対方向に向いて設置された
２つのマイクロフォン、MS コンフィグレーションで左右逆になるマイキング、などを補正するために
用いられます。 
 
 
チャンネルの位相を反転するには： 
 
1. チャンネルノブを押して相当するチャンネル画面にアクセスします。 

 
2. ページ２にある Phase をタップして Invert に設定します。 
 

Info: 位相反転は Basic モードでは無効です。 
 
 

MS Decoder 
 
MS デコーダーをミックスだけに適用し、isolate トラックに適用しない設定ができます。 
 
MS Decode を設定するには： 
 
1.    をタップします。 

 
2. Inputs > MS Decode をタップします。オプション： ISO&Mix, Mix Only 
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Inputs Menu 
 
Input メニューは、Ch9, 10 のチャンネル画面、Aux In モード設定にアクセスできます。 Aux In モ
ードは Aux/Mic In 3.5mm コネクターをどのように使用するかを設定できます。 
 

Selecting Input Sources for Ch9 and 10 
 
Ch 1-8 のチャンネル画面と同様に、Ch5,6 のインプットソースもこれらの画面から選択することがで
きます。 
 
オプションは： 
 Channel 9 : Aux In 1, USB 1, Off 
 Channel 10: Aux In 2, USB 2, Off 
 

Info: これらの画面からソロ、アームトラック、ゲイン調整、PAN、ローカット、リンキングの
設定もできます。 

 
 

Configuring Aux In Mode 
 
Aux/Mic In コネクターを設定するには、Input メニューから Aux In Mode をタップして、つぎのオプ
ションから１つを選択します。 
 

・ Mic: このオプションは、Aux/Mic In にプラグイン・パワーのマイクが使用されるときに設定
します。 
 

・ Line: このオプションは、Aux/Mic In にアンバランスの 2 チャンネル・ラインソースを接続
するときに設定します。例えば、スマートフォンのヘッドフォン出力、ステレオラインソース
など。 
Mic か Line のオプションのどちらかが Aux In モードとして選択されるとき、この 3.5mm ジ
ャックの入力はチャンネルで Aux In 1 か Aux In 2 と設定することでインプット・ソースと
して利用することができます。 
 

・ Camera: このオプションは、ビデオカメラのオーディオ出力を Aux/Mic In を使ってモニタ
ーするときに設定します。ビデオカメラ音声は、MixPre-10T のヘッドフォンとメータービュ
ー3 に位置する C1/C2 メーターでモニターすることができます。 
 
これはカメラに録音されるオーディオを劇的に改善するために MixPre-10T を使用するユーザ
ーにとって特に便利です。 カメラのマイク入力端子のオーディオクォリティは高くないこと
はよく知られており、その代わりに MixPre-10T の入力にマイクロフォンを接続し、
MixPre-10T のステレオ出力をカメラのオーディオ入力に接続ことで非常に優れたサウンド・
クォリティを得ることができます。 その後、カメラのオーディオ出力を MixPre-10T の
Aux/Mic In に接続することによって、カメラオーディオの出力にノイズやディストーション
が無いことをチェックすることができます。 
 
このオプションが選択されるとき、Camera Gain と呼ばれる追加のオプション設定が Input メ
ニューに現れます。 これは入力されるカメラオーディオのレベルを調整するためのゲインで
す。 
 
カメラモニタリングのオプションは、HP プリセットメニューにもあります。 
 

 
Info: Aux In モードが Camera に設定されると、チャンネルの入力に Aux In がルーティン

グされなくなり、もしアサインされていたとしたら録音できません。 
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・ Timecode : このオプションは、Aux/Mic In をタイムコード入力として使用するときに設定
します。 3.5mm TRS コネクターの tip にタイムコード信号が入力されるように配線してくだ
さい。 
 
Info: このオプションを利用する時、Menu > Timecode > TC Mode が Aux TC In である

ことを確認してください。 
 

・ Off: このオプションは、Aux/Mic Input 回路をオフにします。 
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Outputs 
 
 
 
入力に関していかに柔軟性を持たせるかを慎重に考えて設計されているように、出力に関しても同様
に設計されています。 
 
 

Routing L/R and X1/X2 Outputs 
 
MixPre-10T は２ペアの出力、L/R と X1/X2 のトータル４出力バスを持ちます。 L/R TA3 出力はバラ
ンスで、X1/X2 の 3.5mm はアンバランスです。 Basic モードでは、 LR ミックストラックが L/R と
X1/X2 の両方から出力されます。 Advanced モードでは、L, R, X1, X2 出力コネクターの信号ソース
は channel, aux input, USB input, LR ミックストラック からそれぞれ選択することができます。 
 
 
L/R と X1/X2 ステレオ出力へ送るには： 
 
 
1.    をタップします。 

 
2. Outputs をタップします。 

 
3. 次のいずれかを選択します。 

 
・L Output 
・R Output 
・X1 Output 
・X2 Output 
 

4. ルーティングマトリクスから、どのチャンネルをアウトプットへ送るかを選択します。 
下図では、２つのマトリクス設定例を示しています。 
 
 
 
 
 
 
 
 
 
 
それに加え、チャンネルをアウトプットに送る場合、プリフェードかポストフェードのどちらか
を選択することができます。 
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Adjusting Output Level and Delay 
 
出力ゲインの調整は、トランスミッター、外部ミキサー、PA など、出力に接続された機材へ送る信号
を適切なレベルにするために重要です。出力ディレイは、プロダクションでビデオ・オペレーターに
オーディオを送る時に、カメラ映像とオーディオの同期を合わせるために用いられます。 
 
出力ゲインとディレイを調整するには： 
 
1.    をタップします。 

 
2. Outputs をタップします。 

 
3. 次のいずれかを選択します。 

 
・LR Gain 
・X1X2 Gain 
どちらもゲインの調整範囲は 0～ -40dB です。 
 

4. Delay を選択します。 ディレイは 0～400 ms を 1ms 単位で調整できます。 
 
 
 

Output Muting 
 
MixPre-6 上で、3.5mm stereo output をミュートすることができます。 
 
Output をミュートするには： 
 
1.      をタップします。 
2. Outputs をタップします。 
3. St Out Mute をタップし、Mute on/off を切替えます。 
 

・  
Info: Output Mute 機能を *ショートカットボタンに割り当てることができます。 

 
 
 

Headphone Out 
 
MixPre-10T のオーディオ愛好家向けヘッドフォン・アンプリファイアは、ハイパワーで低ノイズなの
で、MixPre-10T が取扱うオーディオを正確にヘッドフォンや環境に関係なくモニターすることができ
ます。 ヘッドフォンプラグを（右側面にある）3.5mm ジャックに接続してください。 ヘッドフォン
音量ボリュームは、ヘッドフォンジャックの隣にあるエンコーダで調整することができます。 

 
Menu 画面から、画面の左上にあるヘッドフォンのアイコンにタッチして、ヘッドフォン・
プリセット（HP Presets）にアクセスすることができます。 このアイコンの上に、現在選択
されている HP プリセットが表示されます。 
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HP Presets メニューに入り、LR Stereo、LR Mono、X1/X2 Stereo、USB1,2、USB3,4、User 
Presets 1-4 の中から選択することができます。 
 
 
 
 
 
 
 
 
 
 
 

Info: ここにリスト表示されているオプションは、Advanced モードで有効です。 LR Stereo、
X1/X2 Stereo、USB 1,2、USB3,4 だけは Basic モードでも有効です。 

 
 
 

Creating a Custom HP Preset 
 
カスタム HP プリセットを作成するには： 
 
1. HP Preset メニューで、User HP Preset の編集や名前を付けるために、Edit HP Preset を選択し

ます。（Advanced モードのみ） 
 

2. 次に、ソロ機能をシングルかマルチに設定するために、HP Solo モードを  Individual か 
Multiple に設定します。 

 
ヘッドフォンアンプは非常に大きな音を出力する能力があるため、不適切な音量レベルにより聴覚に
障害を引き起こす場合があるので、ヘッドフォンを装着するときは御注意ください。 
 
 

Info: ヘッドフォンにクリップ（歪み）が起きると、画面右上の Powerステータス部分に Clip 
インジケータが表示されます。 

 
 
 
 
 
 
 

Disabling Record Bells in Headphones 
 
Audioプロジェクトではデフォルトで録音開始と停止時にヘッドフォンに Recordベルが聞こえます。
これをオフにすることができます。 
 
Record ベルをオフにするには： 
 
1.      をタップします。 
2. Record > Record Bells をタップし、on/off を切替えます。 
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Recording and Playback 
 
 
 
MixPre-10T は、業界標準 WAV ファイル形式で SD カード（SD, SDHC, SDXC）に 192kHz, 24-bit
ｄで最高 12 オーディオトラックまで録音することができます。 SD カードに録音された.WAV ファイ
ルは、MAC、Windows、Linux コンピュータにインストールされたオーディオ・アプリケーション
（ProTools、 Reaper、 Cubase、Garageband、Audacity など）にインポートされ再生することがで
きます。 
 
安心してお使いいただけるよう、SD カードにオーディオを録音しながら MixPre-10T は USB-A ポー
トに装着された外部 USB サムドライブに自動的にコピーする機能を持ちます。これはバックアップ目
的として、またセッション終了直後にコピーをすぐ渡せるという意味でも理想的です。 また、アクテ
ィブなプロジェクトだけでなく事前に保存されたプロジェクトなど、どのプロジェクトでも手動でコ
ピーすることができます。 
 
MixPre-10T を USB オーディオインターフェースとして使用しながら、オーディオのミックス、SD カ
ードへの録音を行うことができます。 これは、コンピュータの USB オーディオ出力を録音したり、
MixPre に接続されるマイクやラインソースとミックスしたりするすばらしい機会を提供します。これ
はポッドキャストや Skype 経由でのインタビュー録音、その他の VoIP アプリケーションに理想的な機
材です。 
 
レコーディングと USB オーディオストリーミングを同時に行う能力は、コンピュータへバックアップ
としてMixPreは理想的な機材です。 特に、コンピュータ1台のみに頼るにはリスクのある重要なイベ
ントの録音に最適です。 
 
レコーディング機能は、オペレーティングモード（Basic モードか Advanced モード）に依存します。  
 
Basic モードでは、MixPre-10T は 2 トラック 48kHz レコーダーとして機能します。この 2 トラック
には LR ミックスが録音され、このオーディオはチャンネルノブ・ゲインによってレベルコントロール
されたものです。 
 
Advanced モードでは、MixPre-10T は 12 トラックレコーダーとして機能し、サンプルレートやビッ
ト深度はさまざまな組み合わせ（44.1, 48, 96, 192kHz / 16, 24-bit）を設定できます。 LR ミックス
トラックだけでなく、各 10 チャンネルのアイソレート・トラックも録音することができます。 ISO
トラック用のオーディオは、”prefade” として録音され、これはチャンネルノブ・ゲインより前の音
なので、チャンネル・ノブの操作は LR ミックスだけに影響し、ISO トラックに録音されるレベルに影
響しません。 これは、後でこれらのトラックを元に別のミックスを作成したいポストプロダクション
でのオーディオ・プロセッシングで特に便利です。 
 
Custom モードでは、ユーザーの好みに合わせて、チャンネルノブでレベル調整した信号（つま
り”postfade”）を ISO トラックで録音するように変更することができます。 
 
 
ISO トラックへのレベルをポストフェードに設定するには： 
 
1. メニュー画面の System > Mode で Custom に設定します。 

 
2. Sysmte > Custom Setup > Gain で Basic に設定します。 
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Formatting SD Cards & USB Thumbdrives 
 
信頼性を持った録音・再生のために、SD カードは必ず MixPre-10T でフォーマットされていなければ
なりません。  
 
USB サムドライブが USB A ポートに挿入されている場合、MixPre-10T は自動的に現在のプロジェク
トで録音されたファイルをそれにコピーします。 この USB ドライブも使用する前に必ず MixPre-10T
でフォーマットされていなければなりません。 
 

Info: メディアをフォーマットするとその中にすべてのデータが消えるため、フォーマットす
る前に必要なデータを必ずバックアップしてください。 

 
MixPre-10T には、最高のパフォーマンスを提供するために最適化された Sound Devices 社ブランド
の SD カードを御使用されることを強くお勧めいたします。推奨されるメディアがお手元にない場合、
もっとも信頼できる製造元（SanDisk か Delkin）のメディアで、class 10 speed を満たすかそれ以上
のものが望ましいです。USB サムドライブに関して、動作の信頼性のために Sound Devices の認証メ
ディア(Approved Media) の使用を強く推奨します。 
 
 
SD カードをフォーマットするには： 
 
1. 背面パネルに位置する挿入口に SD カードを挿入します。 

 
2.    をタップします。 

 
3. SD Card > Edit > Format とタップします。 

 
4. カードをフォーマットする確認画面が表示されたら、OK をタップします。 
 
32GB とそれ以下の容量のカードは FAT32 でフォーマットされます。 32GB より大きな容量の SD カ
ードは exFAT でフォーマットされます。 
 
 
 
USB サムドライブをフォーマットするには： 
 
1. 背面パネルに位置する挿入口に SD カードを挿入します。 

 
2.    をタップします。 

 
3. USB Drive > Edit > Format とタップします。 

 
4. メディアをフォーマットするためのコマンドの確認を求められたら、OK をタップします。 メデ

ィアは exFAT としてフォーマットされます。 
 

Info: exFAT ファイルシステムは、Windows XP や Mac OSX 10.6.4 以前に互換性がありま
せん。 
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Transport Controls 
 
フロントパネルにあるジョイスティック（と点灯式 LED リング）は、さまざまなトランスポートコン
トロール操作に使用することができます。 
 

ファンクション コントロール 詳細 

 

録音 

 

 

 新しくファイルを録音開始するときに押します。 録音中、LED リング

が赤く自照します。 

 

停止 

 

 録音中に押すと停止します。 再生中に押すと停止します。 スタンバイ

中に押し続けると、次に録音するテイクのテイクネームが表示されま

す。 

 

再生 /  

ポーズ 

 

 押すと最後に録音されたファイルまたは現在ロードされているファイ

ルが再生されます。再生中、LED リングが緑色で自照します。再生中に

押すとポーズになり、もう一度押すと再生を再開します。再生ポーズ中、

LED リングとファイルネームが点滅します。 

 

早戻し/  

前テイク呼出 

 

 スタンバイ中に押すと前のテイクをロードします。 再生中に押し続け

ると早戻しします。 再生中かポーズ中に押し続けると、2x 速で早戻し

を始め、5 秒後に x16 速まで加速します。 

 

早送り / 

次テイク呼出 

 

 スタンバイ中に押すと次のテイクをロードします。 再生中に押し続け

ると早送りします。 再生中かポーズ中に押し続けると、2x 速で早送り

を始め、5 秒後に x16 速まで加速します。 

 

Scrub 

 

 再生か再生ポーズ中、ヘッドフォン・エンコーダーを長押しするとスク

ラブモードに入ります。時計回転方向にまわすと早送り、反時計方向に

まわすと早戻しになり、速度は 1/8x, 1/4x, 1/2x, 1x, 2x, 4x, 8x, 16x 

です。オーディオは 2 倍速まで聴くことができます。 

 
 
 

Record Arming 
 
チャンネルをアームするには： 
 
1. チャンネル・ノブを押します。 

 
2. Arm をタップします。 

 
アームされたチャンネルは、メーター・ビューの中でチャンネル番号を囲むラベルが赤く表示さ
れます。 もし隣りのチャンネルとステレオリンクされている場合、それらのラベルが合体してリ
ンクされていることを示します。 
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L,R ミックストラックをアームするには： 
 
 
1.    をタップします。 

 
2. Record > Rec L,R とタップします。 

 
3. 以下から選択します。 

 
 
 
 
 
 
 
 

 

Record Menu 
 
Basic モードでは、互換性のある HDMI 機材のトリガー信号またはタイムコードソースを検知して
MixPre-10T が自動的に録音スタートとストップを行う Trigger ファンクションが有効になっています。 
これにより、カメラ側のレコーディング・スタートボタンだけを押すことで、カメラと MixPre-10T が
同時にレコーディングを開始させることができ、MixPre-10T の録音スタートを忘れる可能性を排除し
ます。 
 
Advanced モードでは、下の表に示されるように多くのセッティングがあります。 
 

サブメニュー 詳細 オプション 

Rec L, R Mix L と R のミックスバスのアーム ・Off 

・L 

・R 

・L&R 

・LR Linked 

Left Gain L ミックス用のゲイン設定。 ・-30 – 0dB (1dB ステップ) 

Right Gain R ミックス用のゲイン設定。 ・-30 – 0dB (1dB ステップ) 

Sample Rate インターナル・サンプルレートと録音される WAV

ファイルのサンプルレート。 

デフォルトは 48kHz です。 

・44.1 kHz 

・48kHz 

・96 kHz 

・192 kHz 

Bit Depth 録音される WAV ファイルのビット深度。 

デフォルトは 24 です。 

・24 

・16 

Pre-roll Time REC が押される前のオーディオ記録を可能にしま

す。 

 

Info:最大プリロール時間は、96kHz とそれ以上で

減少します。 

・0-5 (1 秒ステップ) 

 
 
 

・L&R Linked - 両方のアーム、ゲインはリンク 
・L&R  - 両方のアーム、ゲインは L と R で別々 
・L  - L アームのみ 
・R  - R アームのみ 
・Off  - どちらもアームしない 
・Off & Linked - どちらもアームしない、ゲインはリンク 



 

   

 

 

  33 

 

 
 

サブメニュー 詳細 オプション 

Rec Trigger レコード・トリガーをタイムコードかHDMIフラグ

に設定できます。 

デフォルトは Off です。 

・Off 

・HDMI flag 

・Timecode 

Remix 既存の録音されたファイルを再生し、新しい L&R

ミックス・トラックを作成するものです。Remix

はデフォルトで Off です。 

・Off 

・On 

Record Bells ヘッドフォンに REC 開始／停止のベルを鳴らしま

す。デフォルトは On です。 

・Off 

・On 

 
 
 

Working with Cue Marks 
 
MixPre レコーダーは、重要なポイントにすばやくロケートすることを簡単にするために cue マークを
利用できます。 
 
Cue マークを追加するには： 
 
➢ 録音中、再生中、またはポーズ中、   をタップすると、曲のまさにそのポイントに cue mark

を追加することができます。 Cue mark 番号（01 から始まり、新しい cue mark が追加されると
１つずつ増える）は Q アイコンの横に表示されます。 

 
すでに登録された cue mark の間に新たに cue mark を追加すると、MixPre は自動的に cue mark 番
号を最初から最後まで、 - 01, 02, 03 というように振りなおします。ファイルごとに最高 99 個まで
cue mark を登録できます。 
 
登録された Cue は Cue List の中に、次のイメージ画像のように表示されます。 
 
 
 
 
 
 
 
 
 
 
 
 
Cue マークにアクセスするには： 
 

1.    をタップします。 
 

2. HP エンコーダを操作して、ファイルを１つ選択します。 
 

3. Menu から Cue List をタップします。 
 
Cue List では、Cue に名前を付けたり、時間修正したり、削除したりできます。 
 

Info: Musician plugin がインストールされていると、トランスポート cue point としてオー
トパンチ in/out に使用することができます。 これらの再生・録音用 In/Out ポイント
をリネームすることはできません。 
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Cue マークに名前を付けるには： 
 

1. Cue List から HP エンコーダを操作して cue mark を選択します。 
 
 
 
 
 
 
 
 
 
 
 
 

2. Name をタップし、新しいネームを入力します。 
 
 

Moving Cue Marks 
 
Cue mark の時間は、0.1 秒単位で細かく調整することができます。 
 
 
Cue マークを移動するには： 
 

1. Cue List から HP エンコーダを操作して、cue mark を選択します。 
 
 
 
 
 
 
 
 
 
 
 
 

2. Move をタップし、HP エンコーダを操作して、0.1 秒単位で調整します。 
 
 

Previewing Cue Point Positions 
 
Cue point を細かく調整するために、オーディオをプレビュー再生できます。この再生は cue point の
数秒前から再生されます。 もし cue point がわずかに遅いか早い場合、move 機能を使って位置を細
かく調整できます。 
 
Cue point をプレビューするには： 
 

1. Cue List の中で１つ選択し、Play を押します。 
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Clearing & Deleting Cue Points 
 
Cue mark、Play In, Record In/Out, Stop ポイントを、Cue Points メニューか、Cue List スクリーン
から削除することができます。 
 
 
すべての In と Out ポイントを消すには： 
 
➢ Clr In/Out をタップします。 
 
個々の Play In, Record In/Out, Stop ポイントを消すには： 
 
➢ Cue List から１つ選択し、Disable をタップします。 
 
Cue mark を１つ消すには： 
 

1. Cue List から１つ cue mark を選択します。 
 

2. Delete をタップします。 
 
 

Remixing ISOs 
 
ロケ現場で ISO トラックと一緒に録音された L&R ミックストラックが、後になって良くなかったと判
明したことを想像してください。 もしかすると、ISO トラックの 1 つが小さくてセリフが聞き取りづ
らいとか、もしかすると誰かのラベリアマイクが擦れて ISO トラックに大きなノイズが入っていたと
か。 
 
通常再生は録音されたL&Rミックストラックを聞きます。 しかし、Remix機能は選択されたファイル
を再生し、その ISO トラックのフェーダーやパンニングを再調整することができます。 その再生をリ
ミックスすることで、オリジナルからメタデータを継承しつつ、新しい L&R ミックスを再録音するこ
とができます。 再録音された 2 チャンネル L&R ミックスは、ソースファイルと同じファイル名の頭に 
“R_” がつけられ、新しい poly wav ファイルとして保存されます。 
 
Remix に必要な条件： 
 Advance モード、または、Gain が Advanced に設定された Custom モード。 
 少なくとも１つ以上 ISO トラックを持つソースファイル。 
 
 
Remix を有効にするには： 
 
1.       をタップします。 
2. Record > Remix > On とタップします。 
 
 
L&R トラックに新しいリミックスを再録音するには： 
 
1. Remix が On であることを確認します。 

 
2.      をタップします。 
3. HP エンコーダを操作して、ファイルを選択します。 

（Edit をタップしても選択できます。） 
4. RE-record LR をタップすると、ただちに再生開始されて再録音されます。 
5. 再生中にフェーダーを操作してレベルを調整できます。 
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Metering 
 
 
 

LEDs and Meter Views 
 
MixPre-10T の input と output のメーター監視には５つの基本的な方法があります。 
 
 
・ チャンネル・ノブ・リング LED – 各 LED リングは、グリーン、オレンジ、レッドに光ります。 

LED リングの明るさは、インプットのレベルに応じています。 グリーン = 信号有り、レッド = 
シグナル・ピーキング、オレンジ = リミッター機能動作中。 また、チャンネル・ソロ中は、チ
ャンネルのリング LED がオレンジで点滅し、シンク・リファレンスをロストして同期できないと
きに赤く点滅します。 

 
 
 
 
 
 
 
 
 
 
 
 
・ チャンネル・スクリーン・メーター 
 
 
 
 
 
 
 
 
 
 
 
 
・ メイン LR ステレオメーター 
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・ LR、1-10 マルチトラックメーター 
 
 
 
 
 
 
 
 
 
 
 
 
・ LR、Camera リターン(Aux In)、USB 1,2 メーター 
 
 
 
 
 
 
 
 
 
 
 
３つのメインメーター・ビューを切替えるのは簡単です。 メーターをタッチするだけで、異なるビュ
ーが順に切り替わります。 メーターは信号レベルだけでなく、レコーダー用の各トラックのアームス
テータス、L, R と各チャンネルのリミッター動作状況も表示されます。 
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USB 
 
 
 

USB Audio  Interface 
 
MixPre-10T は、12-in, 4-out の Mac か PC コンピュータと使用するための core audio コンパチブル
なオーディオ・インターフェースを内蔵しています。  
 
PC ユーザーの場合、特定の ASIO ドライバーがインストールされない限り、2x2 オーディオインター
フェースとして MixPre-10T が認識されます。 
 
 
最新の ASIO ドライバーとインストールインストラクションは、以下から無料でダウンロードできます。 
www.sounddevice.com/support/downloads  
 
ホストコンピュータから USB オーディオとして働かせるには、USB 1-4 ソースを適切にルートする必
要があります。 ホストコンピュータからの USB オーディオと MixPre-10T の入力であるライブオーデ
ィオを一緒に LR バスへ送ってミックスしたい場合、チャンネル画面を使ってインプットソースを選択
してください。 USB ホストコンピュータオーディオをヘッドフォンで聴くだけであれば、HP プリセ
ットを USB 1,2 か USB 3,4 に設定してください。 
 
 
MixPre-10T は USB ホストへのストリーミング・オーディオと録音を同時に行う能力があります。 ま
た、コンピュータからの USB オーディオ・ストリーム出力を SD カード・レコーダーで直接録音する
能力もあります。 これはあらゆるコンピュータベースの録音作業において非常に便利な機能です。 
以下の表は、MixPre-10T のチャンネルが USB オーディオの出力へアサインされる詳細について示し
ます。 
 

サブメニュー 詳細 

Channel 1 USB stream 1 

Channel 2 USB stream 2 

Channel 3 USB stream 3 

Channel 4 USB stream 4 

Channel 5 USB stream 5 

Channel 6 USB stream 6 

Channel 7 USB stream 7 

Channel 8 USB stream 8 

Channel 9 USB stream 9 

Channel 10 USB stream 10 

Mix bus L USB stream 11 

Mix bus R USB stream 12 

 
 

http://www.sounddevice.com/support/downloads
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Low-latency Monitoring 
 
レイテンシ（オーディオのプロセッシング・ディレイ）を小さくするために、ハードウェア、ロジック、
ソフトウェアのデザインチームは非常に苦労して MixPre-10T を設計しました。 多くの状況において、
DAW(Digital Audio Workstation)を通してモニタリングするときのレイテンシは、DAW ソフトウェ
ア、プラグイン、コンピュータのハードウェア次第で、完全に許容範囲にあります。 
 
スループット・レイテンシが望まれるものよりも高い場合（遅延時間が長い）には、MixPre-10T に入
力される信号をヘッドフォン出力で直接モニターすることができます。 
 
 
Zero レイテンシでヘッドフォンモニターするには： 
 
1. MixPre-10T をコンピュータに接続します。 

 
2. HP Preset として “LR Stereo” が選択されていることを確認します。 

 
3. Channel 9 用に”USB1” を選択し、Pan L にします。 

 
4. Channel 10 用に”USB2” を選択し、Pan R にします。 

 
5. Channel 1-8 にマイクロフォンや他のソースを接続します。 

 
6. Channel 1-8 を適切な入力タイプに設定します。これらはコンピュータの USB ストリーム 1-8 に

それぞれ現れます。 
 

7. DAW ソフトウェアで Channel 1-8 に相当するソースで新しいトラックを設定します。そしてこれ
らのトラックのレコード・モニタリングが無効であることを確認します。 （また、念の為に DAW
内のチャンネル出力をミュートしておきます。） 
 

8. Channel 9, 10 を通して DAW オーディオの出力を調整し、ヘッドフォンで聴くことができます。 
また、Channel 1-8 のノブを使用してヘッドフォンでモニターされる低レイテンシ（と DAW に
送られるレベル）を調整することができます。 Channel 1-8 と DAW オーディオのミックスを調
整するには、Channel 9, 10 のノブを使用します。 
 

 

USB File Transfer 
 
MixPre-10T は、USB 接続されたホストコンピュータと内蔵 SD カード間のファイル転送をサポートし
ます。 この機能を使うには、MixPre-10T を File Transfer モードにしなければなりません。（USB オ
ーディオ機能は無効になります。） 
 
 
SD カードをフォーマットするには： 
 
1.    をタップします。 

 
2. System > File Transfer とタップします。 

 
3. ファイル転送が完了したら、コンピュータを操作して SD カードをアンマウントします。 次に

USB-C File Trnaser モード画面の Exit をタップして、前の運用状態に戻します。 
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USB Keyboard 
 
スタンダード USB コンピュータ・キーボードをサポートしています。 MixPre-10T を使用していて、
メタデータ入力、タイトル入力、ワイヤーリモートコントロール機能が必要とされるときは、USB キ
ーボードを接続してください。 
 

Info: USB ハブが内蔵されたキーボードや Apple 製のキーボードはサポートしていません。 
また、MixPre-10T の電源を入れた後に接続しないと認識されないものもあります。 

 
 

Copying to a USB Drive 
 
MixPre-10T は、USB A ポートに装着された USB サムドライブに SD カード上のアクティブなプロジ
ェクトを自動的にコピーすることができます。 この便利な機能により、クライエントにコピーデータ
を渡したり、バックアップ目的に利用できます。 USB サムドライブを挿すだけで、あとは MixPre-10T
が処理を行います。 
 
USB サムドライブが接続されると、SD カード録音された現在のプロジェクトのミラーを自動的に作成
します。 前に録音されたファイルのメタデータを編集しても、USB サムドライブに自動的にアップデ
ートされます。 
 
自動コピーは、再生や次の新しい録音開始に影響されることなく、ファイル録音が終了するとコピーを
開始します。これはタイムラグを減らします。その日の収録作業が終わる時、最後の録音ファイルが SD
カードへの保存完了を待つだけです。 
 
また、Project Copy 機能を使うことで、前のプロジェクトを手動でコピーすることもできます。 
 

Info: USB サムドライブの動作の信頼性のために Sound Devices の認証メディア(Approved 
Media) の使用を強く推奨します。Approved Media List は web ページから参照くださ
い。www.sounddevices.com/support/approved-media 

 
 
USB サムドライブへ project を auto-copy するには： 
 
➢ レコーダーの USB A ポートに USB サムドライブを挿入します。 

SD カードに録音されると自動的にコピー作業が発生します。 
 
 
copy の進行中を確認するには： 
 
➢ USB ドライブのステータスが表示されるまで、ステータス・バーをタップします。 
 
 
 
 
 
 
 
 
 
 

Info: copy 進行中に USB ドライブをレコーダーから抜かないでください。 
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auto-copy 中、電源が失われたり USB サムドライブが誤って抜かれたりしても、コピーされたファイ
ルを修復することができます。 単純に、ドライブを挿し直したあとに録音してください。 
 
 
前に録音されたプロジェクトを手動コピーするには： 
 
1.    をタップします。 

 
2. Project > Copy とタップします。 

 
3. コピーしたいプロジェクトをリストの中から選択します。 

プロジェクトがコピーされると、コピー進捗状況が表示されます。 
 

 
 

Adjusting USB Audio Output 
 
MixPre は、USB オーディオのマルチチャンネルをサポートしない（コンピュータ上の）アプリケーシ
ョンと互換性を高めるために、（MixPre の）USB Audio インターフェースを 2 チャンネルだけ出力す
るように設定できます。 
 
USB Audio 出力を 2ch に設定するには： 
 
 
1.    をタップします。 

 
2. Sytem > USB Audio とタップし、 Stereo Out に設定します。 
 
 

Info: USB Audio を Stereo Out に設定すると、MixPre はコンピュータからの USB オーディ
オをレシーブできません。また、同設定にて、ASIO ドライバー(Windows 用) もサポ
ートされません。 
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Timecode 
 
 
 

Timecode /Sync 
 
動画撮影と共にサウンド収録するための機材に、Sound Devices はタイムコード機能を持つオーディ
オレコーダーを提供します。 賞を勝ち取った数々の映画において Sound Devices のオーディオ製品が
使われてきた実績もあります。 
 
MixPre-10T は、さまざまなピクチャーアプリケーション用のサウンド収録にも適するモードと一般的
によく利用されるフレームレートをサポートする高精度、超低ドリフトの SMPTE LTC のタイムコー
ド・ジェネレータ・リーダを備えます。 
 
電源が取り外されても、MixPre-10T は内蔵バッテリーにより正確なタイムコードの歩進を 4 時間続け
るので、長い昼休憩のあとでもタイムコードを再設定する必要がありません。この内蔵バッテリーは、
MixPre-10T がパワーオンの状態で自動的に充電されます。 
 
TC In と TC Out の２つの BNC コネクターをワードクロック（sync）用に動作するよう再設定するこ
とができます。MixPre-10T を高精度マスタークロックとして利用したり、外部マスタークロックに対
するスレーブとして利用することができます。 
 
REC ボタンを押すたびに、その時点のタイムコード値が MixPre-10T のブロードキャスト WAV ファイ
ルの中にストアされます。 ほとんどのポピュラーなビデオ編集アプリケーションはこのタイムコード
値を読み取ることができ、映像と音をシンクさせるために利用することができます。 
 
 

Timecode Modes 
 
MixPre-10T には６つのタイムコード・モード（Free Run、Time of Day、Rec Run、BNC In、Aux TC 
In、HDMI TC In）があります。タイムコード機能はオフにすることもできます。 
 
Timecode Modes を設定するには： 
 
1.    をタップします。 

 
2. System > Timecode > TC Mode を選択します。 

 
 

Free Run 
 
タイムコードが連続的に歩進します。 ユニットの電源を切ってから 4 時間までは、内蔵バッテリーに
よりタイムコードが正確に歩進します。 
 

Rec Run 
 
レコーディング中にタイムコードが歩進し、レコーディングしていない時は停止します。 このモード
では、電源を入れたときにタイムコードが最後に停止した値に設定されます。 他のモードから
Record Run に切り替えた時、インターナルジェネレータは最後のタイムコード値で停止します。 
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BNC In, Aux TC In (External LTC) 
 
タイムコードは、TC In BNC か 3.5mm Aux/Mic In コネクターに入力された外部タイムコードを利用
します。 
 
 
1.    をタップします。 

 
2. System > Timecode > TC Mode で、BNC In か Aux TC In を選択します。 

 
 

HDMI TC In 
 
HDMI TC In を利用している時、MixPre-10T は HDMI にシンクし、カメラとレコーダーの間はゼロ・
ドリフトとなります。 HDMI 出力コネクターにタイムコード信号を出力できるカメラを使用してくだ
さい。 
 
この機能を利用できるカメラのいくつかのサンプルとして、Sony a7s と Panasonic GH4/GH5 があ
ります。カメラの HDMI 出力を MixPre-10T の右側面にある HDMI TC In ポートに接続し、Menu > 
Timecode > TC Mode で HDMI TC In を設定してください。 カメラの取扱説明書を参照してカメラ
から HDMI タイムコードを出力するようカメラを設定してください。 
 

Info: HDMI ソースが接続されていないのに HDMI TC In が選択されると、MixPre-10T はシ
ングを失ったとレポートします。これは HDMI TC In を使用中は MixPre-10T が必ず
HDMI にシンクするためです。 これは HDMI カメラと MixPre-10T の間でゼロ・ドリ
フトを確実にするものです。 

 
 

Time of Day (TOD) 
 
24 時間 Run モードとも呼ばれます。 フリーラン・モードと似てはいますが、タイムコード・ジェネ
レータが自動的にシステムクロック時計をロードします。 録音されるWAVファイルに TIME OF DAY
でタイムコード・スタンプしたい場合に TOD モードを使用してください。 
 

Off 
 
Tc Mode を Off に設定すると、タイムコード機能が無効になります。 オフの時、ホーム画面上のファ
イルネームの下に表示されるタイムカウントは、タイムコードではなく経過時間が表示されます。 
 

Timecode Display 
 
タイムコードが有効な時、ホーム画面上のファイルネームの下にタイムコード値が表示されます。 タ
イムコードはスタンダードな HH:MM:SS:FF 形式で表示されますが、タイムコードフレームレートが
ドロップフレームの場合は、秒とフレームの間をセミコロンで分けた HH:MM:SS;FF 形式で表示され
ます。 
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Setting the Frame Rate 
 
外部 TC モード（BNC In、Aux TC In、HDMI TC In）が使用される時、フレームレートを設定する必
要はありません。MixPre-10T は入力されるタイムコード信号のフレームレートを自動的に識別し、フ
レームレートを設定します。 
 
しかし、インターナル TC モード（Rec Run、Free Run、TOD）が使用される時、インターナルタイム
コード・ジェネレータのフレームレートを設定することは重要です。 
 
フレームレートを設定するには： 
 
1.    をタップします。 

 
2. Timecode > Frame Rate で（23.98, 24, 25, 29.97nd, 30, 30nd）から選択します。 

 
 

Setting Generator Timecode and UBits 
 
External Timecode モードの時、Ubits を設定できます。 Free Run か Rec Run モードの時、タイム
コード・ジェネレータの初期値と UBits を設定することができます。 
 
timecode 値を設定するには： 
 
1.    をタップします。 

 
2. Timecode > Set TC で、エンコーダを操作して 時(HH)、分(MM)、秒(SS)、フレーム(FF) の値

を入力します。 入力された値は TC ジェネレータにロードされ、ホーム画面の中に表示されるフ
ァイルネームの下にタイムコード値が表示されます。 
 

 
UBits を設定するには： 
 
1. Timecode メニューから、Set UBits > Mode にアクセスします。 

 
2. エンコーダを操作して UBit モードを次のオプションから選択します。 

オプション： U:U:U:U、M:D:Y:U、D:M:Y:U、External 
 

Info: M は付、D は日、Y は年、U はユーザー設定を表します。 External が選択されると、
external UB ソースが、AuxIn か BNC In から表示されます。 オレンジボタンをタッ
プして UB ソースを変更できます。 

 
3. モードを選択した後、任意の hex 値を各 UBit フィールドで入力します。各フィールドの設定値の

範囲は 0 から F です。 
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Jamming Timecode 
 
Free Run モードの時に、手動でジェネレータのタイムコードを設定できることに加えて、外部 LTC タ
イムコード信号にインターナル・ジェネレータをジャム（同期）させることもできます。ジャミングす
ることで、カメラやデジ・スレートのようなデバイスとケーブルやワイヤレス機能を用いずに同じタ
イムコードカウントを保持することができます。 MixPre-10T の、超低ドリフトのタイムコード・ジ
ェネレータは、長時間にわたって精度の高いタイムコード歩進を続けます。 
 

Info: MixPre-10T は HDMI TC In にジャムできません。 
 
MixPre-10T をジャムするには： 
 
1. 外部タイムコードとして BNC In か Aux In のどちらを使うか選択します。 

 
2. 外部 LTC タイムコードを接続します。 

 
3. Menu > Timecode > TC Mode を Free Run に設定します。 

 
4. Menu > Timecode > Frame Rate を任意のフレームレートに設定します。 

 
通常、インターネル・ジェネレータのフレームレートは、入力されるタイムコード信号と同じフ
レームレートに設定します。 

 
Info: しかし、クロスジャムさせることは可能です。クロスジャムとは、入力される信号のレ

ートが MixPre-10T と互換性を持ちながら異なるものとジャムさせることです。互換性
のあるレートとは、両方が整数（24,25,30）である、または両方が整数ではない（23.98, 
29.97nd）レートを指します。 

 
5. Menu > Timecode > Jam にアクセスすると、Jam 画面が標示されます。 

 
 
 
 
 
 
 
 
 
 
画面には、インターナルとエクスターナルのタイムコード値、それら２つの差分（Diff）が表示さ
れます。 
 

6. Source をタップし、ジャムソースを選択するために BNC In か Aux TC を選択します。 
 

7. Jam TC をタップし、ジャミングが成功すると、 Diff = 00:00:00:00 と表示されます。 
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BNC Out – Timecode or Word Clock 
 
工場出荷時設定で、TC Out BNC はタイムコードを出力します。しかし、MixPre-10T を高精度マスタ
ークロックとして使用したい場合は、ワードクロックを出力するよう設定することができます。 
 
TC Out BNC を設定するには： 
 
➢ Menu > Timecode > BNC out で、Timecode か Word Clock を選択します。 
 
 

BNC In – Timecode or Wordclock 
 
工場出荷時設定で、TC In BNC はタイムコード受信に設定されています。しかし、外部ワードクロッ
ク信号を受信するよう設定することができます。 
 
TC In BNC を Word Click に設定するには： 
 
Menu > Timecode > BNC In で、Word Clock を選択し、ワードクロックソースを BNC コネクター
に接続します。 
 
 

Sync Ref 
 
MixPre-10T は、外部タイムコードに対するスレーブに設定したり、BNC In ポートに接続されたワー
ドクロック信号をシンクリファレンスに設定したりすることができます。 
 
シンクリファレンスは、A/D と D/A、タイムコード、ファイル書込に利用されます。 External に設定
されると、MixPre-10T のサンプリング周波数は外部ソース機器に同期します。 
 

Info: LTCシンクリファレンスに利用できるのは、3.5mm LTC入力ではなく、BNC Inputut だ
けです。 

 
Sync reference を設定するには： 
 
Menu > Timecode > Sync Ref を Internal か BNC In のどちらかに設定します。 
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Projects and Files 
 
 
 
REC ボタンを押すたびに、MixPre-10T は WAV オーディオファイルを作成します。この WAV ファイ
ルは MixPre-10T やほとんどのコンピュータオーディオアプリケーションで再生することができます。
MixPre-10T は最大 12 トラック（ステレオミックス LR＋アイソレート・トラック 10）までを１つの
ポリフォニック WAV ファイルに録音することができます。 ポリフォニックは、ファイルがマルチト
ラックのデータを含むということを単に意味します。 
 
１つの SD カードの中に何百もの WAV ファイルを収納することができ、カードを何枚か差し替えて利
用することで数ギガバイトにもなるオーディオデータを持つことができます。 数多くのファイルが煩
雑にならないよう体系化するため、ファイルは個々に、ユーザーが名前をつけたフォルダ（それは
MixPre-10T ではプロジェクトと呼ばれます）に保存されます。例えばユーザーは、INTERVIEWS, 
WILD TRACKS, SOUND FX, MUSIC などのように、プロダクションネーム、日付、またはカテゴリ
ーなどをベースに録音ファイルの保存フォルダを構成することができます。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
プロジェクトは、どんなときでも１つだけがアクティブになります。 もしユーザーがプロジェクトを
意識して作成しなくても、MixPre-10T は自動的に現在の日付を元にしたネームでプロジェクトを作成
して保存します。プロジェクトがアクティブである間、そのプロジェクトフォルダに録音されたすべ
てのファイルが保存されます。 すべての有効なプロジェクトのファイルは File List から閲覧すること
ができます。 
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Managing Projects 
 
File List では、アクティブなプロジェクトの中に録音されたすべてのファイルが時系列順にリスト表示
されます。 
 
File List にアクセスするには： 
 
➢ ホーム画面の上部にあるファイルネーム表示領域をタップします。 
 
 
 
 
 
 
 
 
リストの一番上にあるアイテムは、次に録音される NEXT file です。そのすぐ下が、最後に録音され
たファイルもしくは現在録音中のファイルで、リストのそれ以降にはすでに録音された前のファイル
が表示されています。 
 
File List では、アクティブなプロジェクトのファイルに対して以下のさまざまなタスクを実行すること
ができます。 
・ すべてのファイルとそれらの録音時間。 
・ 再生用に１つのファイルを選択する。 
・ ファイルのメタデータ（name, number, notes, track names）を編集する。 
・ ファイルのリネーム。 
・ 最後に録音されたファイルのアンドゥ。 
・ トラッシュ・ファイル。 
 
HP エンコーダを操作してリストの中をスクロールし、再生または編集するためにファイルを選択して
ください。 
 
リストからファイルを再生するには： 
 

➢ ファイルを選択し、再生するために PLAY を押します。 
 
 
ファイルのメタデータを編集するには： 
 
➢ ファイルを１つ選択してから HP エンコーダを押すか、上記にリストされているタスク実行可能な

Edit メニューにアクセスし、Edit をタップします。 
 
 
新しいプロジェクトを作成するには： 
 
1.    をタップします。 

 
2. Project > New とタップし、カスタムプロジェクトネームを作成するか、現在の日付をベースと

するプロジェクトネームを選択します。 
 

Info: プロジェクトネームは 18 文字まで記入できまうｓ。プロジェクトネームは PC でプロ
ジェクトフォルダーの名前として現れます。 
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すでに作成されたプロジェクトの中に新たに録音するには： 
 
1.    をタップします。 

 
2. Project > Open とタップします。 

 
3. 任意のプロジェクトを選択します。 選択されたプロジェクトのファイルが File List にロードされ

ます。 
 

Info: メータービューの上部のファイルネームをタッピングすると、現在の開かれているプロ
ジェクトの File List が表示されます。 

 
 
プロジェクトを削除するには： 
 
1.    をタップします。 

 
2. Project > Trash とタップします。 

 
3. 削除したいプロジェクトを選択すると、選択されたプロジェクトとそのファイルが TRASH フォル

ダに移動します。 このフォルダの中のプロジェクトは、コンピュータでアクセスすることができ
ます。 

 
Info: MixPre-10T の Drive サブメニューから、SD カードの中の TRASH フォルダ内を完全に

削除することができます。 
 
 

File Name Format 
 
MixPre-10T は、録音前、録音中、録音後にレコーディング（WAV ファイル）に名前をつける事ができ
ます。 
 
各レコーディングのファイルネームは、テキスト（最大 9 文字）とそれに続くダッシュ（-）とその後
に番号（３桁）で構成されます。 例えば： 
 

123A-001.WAV 
ネーム (シーンネーム) = 123A 
ナンバー (テイクナンバー) = 001 

 
REC ボタンを押すたびに、番号は増加します。 
新しいテキスト（名前）を作成すると、番号は 1 にリセットされます。 
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Naming a Recording 
 
レコーディングに名前をつけるには： 
 
1. Home 画面の左上あたりをタップして、File List にアクセスします。 

 
2. 右側面にある HP エンコーダを使って、リストからファイルを選択します。 
 

Info: File List の上部に最近録音されたものが年代順に表示されまうｓ。 リストの一番上に位
置するものは次に録音される next file です。 録音開始前に next file を選択してリネー
ムすることができます。  

 
3. テキストを編集するためにネームを選択します。 

 
4. 番号を編集するために、番号を選択します。 

 
テキスト（名前）と番号は、レコーディングされたファイルネームに適用されるだけではなく、
WAV ファイルの中にエンベデッドされます。 これはフィルムや TV プロダクションにおいてログ
参照とコンテンツにすばやくアクセスするために利用されるものです。 

 
Advanced モードでもレコーディングをリネームすることができます。 
 
 
録音されたファイルをリネームするには： 
 
➢ File List に入って、エンコーダでファイルを選択し、Rename をタップします。 
 
 

Track Names and Notes 
 

Advanced モードでは、トラックネームの設定、WAV ファイルの中にノートを記述することができま
す。 これはマルチトラックレコーディングに求められる機能で、誰の声が特定のトラックに録音され
ているかをわかりやすくし、レコーディングに関する補足情報をメモすることで、後のポストプロダ
クションで便利になります。 
 
トラックネームとノートを編集するには： 
 
1. File List の中で、ファイルの１つを選択しエンコーダを押します。 

 
2. 次のいずれかの操作を行います。 
 

➢ トラックネームを変更するために、トラックネームを選択します。 
➢ ノートを編集するために Notes を選択します。 

 
関連するチャンネル画面からもトラックネームを編集することができます。例えば： 
 
 
ISO トラック 1 のネームを編集するには： 
 
1. Ch-1 のノブを押します。 
2. チャンネル画面の左上をタップします。 
3. 任意のトラックネームを Ch-1 用に入力します。 
 
編集されたトラックネームは、チャンネル画面の上部に表示され、現在録音されているファイル、そ
れに続く録音ファイルのメタデータ領域にエンベデッドされます。 
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Undo, Trash File 
 
Advanced モードでは、最後に録音されたファイルをアンドゥすることができます。 アンドゥすると、
最後に録音されたファイルは SD カードの中の UNDO フォルダに移動します。 このフォルダの中のフ
ァイルはコンピュータを使ってアクセスすることができます。 
 

Info: USB サムドライブは UNDO フォルダがありません。  
 
 
最後の録音をアンドゥするには： 
 
➢ File List で、ファイルを選択し、エンコーダを押して、Undo をタップします。 
 
 
ファイルを Trash フォルダに移動するには： 
 
1. File List で、ファイルを１つハイライト状態にして、Edit をタップします。 

 
2. Trash テイクを選択します。 
 
Trash ファイルは SD カードの TRASH フォルダに移動します。 このフォルダの中のファイルはコンピ
ュータを使ってアクセスすることができます。 MixPre-10T の SD Card メニューから、この TRASH
フォルダの中のファイルを完全に削除することができます。 
 
 

Sound Reports 
 
MixPre-10T は、.csv 形式のサウンドレポートファイルを、アクティブなプロジェクト用に生成するこ
とができます。 レポートファイルには、録音されたすべてのファイルとプロジェクトセッティングに
関する有益な記述情報が含まれます。 これは、レコーディングセッションのログとして利用できる他、
クライエントやポストプロダクションへ、オーディオファイルと一緒に送ることのできるエレクトリ
ック・レポートです。 
 
拡張子.csv のファイルフォーマットは、ほとんどのスプレッドシート（表計算）アプリケーションにイ
ンポートされることができ、プロジェクトの情報が列と行に見やすく表示されます。 
 
サウンドレポートに記述される内容はカスタマイズすることができます。 Producer、Director、Job、
Name、Location、Phone、E-mail、Client といったようなプロジェクトの詳細についてのヘッダー
インフォメーションを編集することができます。 
 
 
サウンドレポート info をカスタマイズするには： 
 
1.    をタップします。 

 
2. Project > Report Info とタップします。 

 
3. 画面上のバーチャルキーボードか接続された市販の USB を使用して、各 info アイテムに情報を入

力します。 
 
場合によっては、アイテム情報をブランク（空白）のまま残してもかまいません。その場合、単
に.csv レポートに未記入アイテムが表示されないだけです。 
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サウンドレポートを作成するには： 
 
1.    をタップします。 

 
2. Project > Create Report とタップします。 

 
.csv サウンドレポートファイルは、アクティブなプロジェクトのフォルダの中に、オーディオフ
ァイルと一緒に保存され、次のように名前が付けられます。：ActriveProjectName_Report.csv 

 
 
.csv ファイルを利用（閲覧）するには： 
 
1. SD カード、USB サムドライブ、File Transfer 機能を利用して、コンピュータにファイルを転送し

ます。 
 

2. Excel、Numbers、Google Spreadsheets など、使いなれたスプレッドシート（表計算）アプリ
ケーショでファイルを開きます。 
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Remote Control 
 
 
 

Wingman Application 
 
Sound Devices Wingman は、- Google Play と App Store からダウンロードできる – フリーapp
で、Android か iOS 端末から MixPre シリーズの Bluetooth Smart のリモートコントロールを行うも
のです。 
 
MixPre レコーダーで Bluetooth を有効にするには： 
 
 
1.    をタップします。 

 
2. System > Bluetooth とタップします。これにより Bluetooth 機能を On/Off できます。 

 
 

Info: もしレコーダー上でリモートパスワードが設定されていると、Wingman は接続開始前
にパスワードの入力を求めます。 
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Wingman のタッチ画面インターフェースは、３つのメインエリアで簡単操作とモニタリングを提供し
ます。 
 
⚫ ステータス - デバイスの詳細な情報を表示。 
⚫ ビューエリア –トランスコントロール・ボタン、メタデータフィールド、レベルメータのあるト

ランスポート・ビューといった異なるスクリーン・ビューの表示。 
縦にスワイピングして他のメーターにトグル切替。 
小型の iOS デバイスで Wingmann app を利用するとき、水平にスワイピングして、トランスポー
トとトラック・ビュー間の切替。 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
・ Tab バー - タブはどの画面でも常に表示されていて４つのアイコンがあります。 File List といっ

た他のビューにアクセスするためにタブを利用します。 
 

Info: 小型モバイルデバイスでは、カスタムネームとトラックアームは Track ビューで操作で
き、大型モバイルデバイスでは Transport ビューで操作できます。 

 
 
 

Connecting to a MixPre Recorder 
 
もし、Wingmanを利用できるSound Devicesデバイスが複数ある場合、Wingmanは通信範囲にある
有効なデバイスがすべて表示します。Connection アイコンをタップして接続先のデバイスを app から
切り替えることができます。 
 

Info: 同じ型番のレコーダーを複数利用する作業では、丸で囲まれた i マークをタップすると
該当のレコーダー画面に”Identifying from Wingman”メッセージが表示されるので、
正しいデバイスを認識するのに役立ちます。 
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Wingman が動作中、画面に Sound Devices ロゴのアイコンの色で接続状況が示されます。 
 

カラー アイコン ステータス 

グレイ 

 

 

 切断中 – デバイスの不在、またはデバイススキャニング中。 

オレンジ 

 

 

 Bluetooth 接続途中。 

イエロー 

 

 

 接続中 - 認証途中。 

グリーン 

 

 

 接続中 – 認証完了。 
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Music Projects via Wingman 
 
Wingman アプリの ver3.20 以降で、M モデルの MixPre シリーズ、Musician Plugin がアクチベート
さ MixPre モデルを含むすべての MixPre モデルとの Bluetooth 通信をサポートします。 
 
MixPre と接続すると、MixPre シリーズ上で開かれているプロジェクト、接続されているモデルに応じ
て、Wingman のユーザーインターフェースが変わります。 
 
例えば、Music projectでは、トランスポート・ビューは、12トラックのシングルメータービューを表
示します。 Music projectはファイルリストが無いので、タブ・バーからFile Listアイコンが削除され
ています。 Rec と Stop に加えて、Play のトランスポート・コントロール・ボタンが、Audio project
において False Take (Undo) ボタンの代わりに表示されます。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Info: モデルやプロジェクトに関係なく、大画面のモバイルデバイスではトランスポート・
ビューで、小画面のモバイルデバイスではトラック・ビューで、カスタムネームとト
ラックアームを設定できます。 
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トラックネームを編集するには： 
 
1. 次のいずれかを操作します。 
 

➢ 大画面モバイルデバイスで、トランスポート・ビューから、編集したいトラックのメーターの
どこかをタッチします。 

➢ 小画面モバイルデバイスで、トラック・ビューから、編集したいトラックのメーターのどこか
をタッチします。 

 
2. 画面のバーチャル・キーボードを使ってトラックネームを編集します。 
3. Done をタップして変更を確定します。 
 

Info: キーボード以外の他の場所をタップすると、編集をキャンセルできます。 
 
 
トラックをアーム／アーム解除するには： 
 
➢ メーターラベルをタップします。 アームされると赤色に変わります。 チャンネルが On でアーム

が解除されるとラベルは灰色です。 チャンネルが Off だとラベルは黒色でアーム設定できません。 
Music project でチャンネルが On でアーム解除されている時、再生中かオーバーダビング中のラ
ベルは緑色です。 

 
Info: チャンネルがリンクされている時、隣り合うメーターラベルが合体して、１つのラベ

ルとして表示されます。 
 
 
 

HDMI Record Trigger 
 
対応している一眼レフカメラの HDMI 出力からの HDMI レコード・フラグをトリガーとして
MixPre-10T の録音を開始させるように設定することができます。デフォルト設定で、レコード・トリ
ガー設定は Off です。 レコート・トリガーを HDMI フラグに設定すると、HDMI 入力を介して対応す
るデバイスがレコード・フラグを発する時に録音が始まります。 
 
Record Trigger 設定にアクセスするには： 
 
1.    をタップします。 

 
2. Record > Rec Trigger とタップします。 

 
 
 

Linear Timecode (LTC) Record Trigger 
 
Aux 入力を Timecode に設定し、歩進する LTC タイムコードを検知すると MixPre-10T の録音を開始
させるように設定することができます。 Rec Trigger を Timecode に設定するとこの機能が有効にな
ります。 
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Keyboard 
 
MixPre-10T の特定の機能をリモートコントロールするために、USB キーボードを接続することができ
ます。以下の表は、USB キーボードのショットカット操作です。 
 

USB キーボード・ショートカット 
 
USB キーボードが接続されると、つぎのキーコンビネーションまたはショートカット操作が有効で
す。 
 

キーストローク アクション 

Escape 戻る。 バーチャルキーボードが画面にあるとき、編集モードをキャンセル。 

F1 か Menu キー メインメニューにアクセスします。 

F12 Home 

F2 File list 

F3 メータービュー画面とメイン画面の切替 

Ctrl + R 録音 

Ctrl + S 停止 

スペースバー 再生 

左矢印 メイン画面：早戻し 

メニューと入力設定画面：ページ切替 

右矢印 メイン画面：早送り 

メニューと入力設定画面：ページ切替 

上／下 矢印 メイン画面：ヘッドフォン音量調整。 

メニューの中：エンコーダ回転操作と同じ。スクロールリスト、ハイライトの移

動など。 

パラメータ編集中：値の変更。 

Enter メニュー画面：現在の選択を確定。（エンコーダ押し操作と同じ）。 

バーチャルキーボード画面があるとき、OK の選択と同じ。 

Q メニュー画面：４ボタンビューで左上のオプション選択。 

W メニュー画面：４ボタンビューで右上のオプション選択。 

A メニュー画面：４ボタンビューで左下のオプション選択。 

S メニュー画面：４ボタンビューで右下のオプション選択。 

1-8 チャンネルセッティング画面 1-8 
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USB Controllers 
 
 
 
Ver 3.00 以上の firmware から、MixPre シリーズ（M モデルを含む）にサードパーティ製のハードウ
ェア・コントローラを接続して快適なミキシング、レコーディング環境で作業することができます。 
 
楽曲制作、ポットキャスト、映像用のオーディオ録音に限らず、あらゆるアプリケーションにおいて、
フロントパネルのノブや Bluetooth 通信によるモバイルデバイスからのリモート操作に加えて、ハー
ドウェア・コントローラを追加することでより一層 MixPre の操作性が向上します。 
 
MixPre シリーズは、次の USB コントローラから操作することができます。 
 Korg NanoKontrol Studio 
 Korg NanoKontrol 2 
 Novation LaunchControl XL 
 Akai MidiMix 
 
これらのコントロール・サーフェースは、フィジカル・スライダー、ポット、ボタンなどで、フェー
ダーレベル、トリムゲイン、パン、リバーブセンド、ソロ、ミュート、REC アーミング、トランスポ
ート・コントロールを操作することができます。 
 

Info: すべての機能がすべてのコントローラでサポートされているわけではありません。 
 
 
 

Connecting the MixPre to a Controller 
 
MixPre と USB コントローラの接続性を簡便化するため、1 本の USB ケーブルにより通信と電源供給
が行われます。 接続されたコントローラの互換性を確実にするため、MixPre は接続されたコントロー
ラに合わせて自動的に構成されます。 
 

Info: MixPre-3と-6は、電源供給が不足すると省電力モードに入り、USBポートが使用でき
なくなります。 

 
コントローラを接続するには： 
 
1. MixPre の USB-A ポートに USB ケーブルの一端を挿入します。 もう一端は使用する機器に合わせ

た USB-B, Micro USB, Mini USB のプラグとなります。 
 
コントローラに付属した USB ケーブルを使用することをお勧めします。 

 
Info: MixPre の電源が入った状態でコントローラを接続しても問題ありません。 

 
2. MixPre は接続されたコントローラに合わせて自動的に構成を開始します。短い時間ですが、画面

には接続されたコントローラの名称がポップアップします。 数秒後、ポップアップ画面が消えた
らコントローラーは使用可能です。 

 
Info: MixPre に接続されると、一部の機能がコントローラ側に移行するため、その機能は

MixPre 上で操作できなくなります。 コントローラのモデルによりますが、fader, 
trim, pan, reverb send, low cut filter などの機能が移行します。 
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Map User-Definable Buttons to Shortcuts 
 
コントローラ上のボタンやノブの役割を MixPre 上の特定の機能にカスタマイズすることができます。 
アサインできる機能は以下です。 
 
 Tone 
 L/R Mute 
 X1/X2 Mute 
 Undo (Audio project のみ) 
 Slate Mic (MixPre-10T の Audio Project のみ) 
 Metronome (Music project のみ) 
 Add Q (Cue ポイント追加) 
 Record 
 Stop 
 Play 
 Rewind 
 Fast Fwd 
 Shuttole (すべてのコントローラに対応していません) 
 
 
コントローラのボタンに機能を割り当てるには： 
 
1. コントローラを接続します。 
2. MixPre の画面で、Menu > *Shortcuts > Control Surface にアクセスします。 
3. お好みの機能を設定可能なボタンに割り当てます。 
 
 
 

Controller Interface 
 
それぞれ、サードパーティ製コントローラによって使い勝手が違います。 次のセクションで、各コン
トローラの詳細について説明します。 
 

Info: MixPre-M シリーズは、Audio project をサポートしません。 
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Akai MidiMix インターフェース 
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Korg NanoKontrol 2 インターフェース 
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Korg NanoKontrol Studio インターフェース 
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Novation LaunchControl XL インターフェース 
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Musician Plugin 
 
 
 
 
Musician plugin はコンピュータベースのミュージック・プロダクション・ソフトウェアのエッセンス
を MixPre-3, -6, -10T レコーダーにもたらします。 
 
ミュージシャンとソングライターは、簡単操作、ポータブルツールの高品質、マルチ・レイヤーの楽曲
制作機材でいつでもどこでも、作曲イメージを録音して残す事ができます。 
 
MixPre-10M には、ミュージシャンに必須な多くの機能が実装されています。 
 
 トラック・レイヤリング 
 オーバーダビング 
 パンチイン／アウト 
 キューポイント 
 トラック・バウンシング 
 リバーブとヴォーカル・エアーのエフェクト 
 メトロノーム 
 エクスポート 

 
 
MixPre-10M は、Protools, Logic, Cubase, Reaper のような DAW と似たような機能として動作しま
す。しかし、その特化したハードウェアにより、一般的なコンピュータベースのシステムでありがちな
技術的要因で行き詰まることなく、ミュージシャンは楽曲制作に専念することができます。ミュージシ
ャン、ソングライターは簡単操作、高品位な収録用のポータブルツールを使用して、いつでもどこでも
インスピレーションのままに楽曲をマルチレイヤーに収めることができます。 
 
MixPre-10M は、8 つの XLR 入力からのオーディオ・ソースを一度に 8 トラックまで同時に録音するこ
とができます。正しいテンポで演奏できるようにメトロノーム機能、レコーディング時にキャラクター
要素を加えることのできるリバーブとヴォーカルエラー・エフェクト機能が内蔵されており、すばらし
いパフォーマンスを支援してくれます。ヴォーカルエアー・エフェクトは、快活で艶を持たせた親密さ
のあるヴォーカルになる効果を出す EQ とコンプレッションの複合機能で、シンガー／ソングライター
には人気があります。 
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Installing and Activating the Plugin 
 
Musican plugin は Sound Devices のウェブページのオンラインストアから購入できます。 
https://store.sounddevices.com/product/musicians-plugin/ 
 
plugin のインストールとアクチベートするには： 
 
1. ファイル拡張子 .LIC のライセンス・ファイルを購入、ダウンロードして SD カードに入れます。 
 
 

Info: Musican Plugin は MixPre レコーダーとそのシリアル番号にラインセンスされており、
他の機材にライセンス権を変更したり、複数の MixPre 機材で流用はできません。 

 
2. SD カードを MixPre に挿入し、レコーダーの電源を入れます。 

 
 
1.    をタップします。 

 
2. System > Plugins をタップします。 

 
3. Apply Plugins をタップします。 これでライセンスがインストールされ、プラグインがアクチベ

ートされます。 ユニットのリブート後に利用可能です。 
 
 

Music Projects 
 
SD カード上の各ミュージック・プロジェクトのフォルダは、歌や楽曲、そしてセッティングが格納さ
れます。プロジェクトとは本質的には、SD カードの１つのフォルダの中に格納されたすべてのオーデ
ィオ・ファイルとミキシング・セッティングを指します。 ユーザーによって創作された楽曲はフォル
ダで管理されるため、バックアップやコピーも簡単です。プロジェクト・フォルダには特別な「セッシ
ョン」ファイルも含まれ、これは、録音されたオーディオ・ファイルがどのトラックで、またどのタイ
ムラインで再生されるかを MixPre-10M が正確にコントロールするためのファイルです。 
 
概念的に、１つのミュージック・プロジェクトは一般的な DAW と同じく働き、ユーザーが思い描く通
りのものです。 プレイ・カーソルは水平タイムライン上を移動し、複数のオーディオ・トラック（MixPre
の中ではチャンネルとして扱われる）が縦に並びます。 局は常に 00:00:00:0 (hh:mm:ss:tents)か
らスタートします。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

   

 

 

  71 

 

 
 
ユーザーは多くのプロジェクトを 1 枚の SD カードに収めることができるだけでなく、異なるプロジェ
クトへすばやく切替えられるので、アルバム制作など複数曲の平行作業にも柔軟に対応できます。 な
お、MixPre-10M では一度に１つのプロジェクトだけをアクティブに操作できます。 
 

Music Project Folder Structure 
 
１つのプロジェクト・フォルダにはつぎのファイルが含まれます。 
 プロジェクトの録音されたオーディオ WAV ファイル。 トラックで録音された、またはオーバー

ダブされたものは、シングルのモノフォニック WAV ファイルです。 
 

Info: ファイルネームは録音完了の日付と時間を元にしています。例えば、2018 年 3 月 23
日 1:33PM(13:33)に録音完了したファイルは 001-032318-133300 となります。 

 
 １つのレンダーフォルダは、すべてのレンダーされたオーディオ・ファイルと、１つの

SESSION.XML ファイル（プロジェクト用に保存されているセッティングとオーディオ・ファイル
の再生状況を管理する）が含まれます。 

 
プロジェクト・フォルダのコンテンツをコンピュータで確認することができます。 
 
 

Creating a New Music Project 
 
新規 Music プロジェクトを作成するには： 
 

1.    をタップします。 
 

2. Project > New > Music をタップします。 
 
 
 
 
 
 
 
 
 
 
 

3. 名前を入力して OK をタップします。デフォルトでネームは、Song1 といった数字が割り当て
られています。 
 

4. Create をタップします。 新しい Music プロジェクトが作成され、Home スクリーンの上部に
プロジェクトネームが表示されます。 
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Import Recording 
 
新規プロジェクト作成時、.wav オーディオファイル（12tracks まで）をプロジェクトの基礎としてイ
ンポートできます。 DAW からマルチトラックオーディオをインポートして、MixPre で楽曲制作を続
けることができます。あるいは、ライブパフォーマンス用に DAW で作成したバッキング・トラックを
インポートして、MixPre をパフォーマンス中の再生装置とミキサーを兼ねるオールインワンデバイス
に利用できます。 
 

Info: MixPre-3, 6, 10T の Audio プロジェクトで録音された.wav ファイルを、Music プロジ
ェクトにインポートすることもできます。ファイルネームは 40 文字以下にしてくださ
い。長いファイルネームはサポートされません。 

 
 
非ネイティブ WAV ファイルをベースに新規プロジェクト作成： 
 
1.       をタップします。 

 
2. Project > New > Import recording をタップします。 

 
3. SD カード上のインポートしたいファイルを選びます。 

 
＞ HP エンコーダを操作して SD カードのルートにある.wav ファイルを選択します。 
＞ Audio プロジェクト・フォルダを選択し、その中の.wav ファイルを選択します。 
 

 
 

Opening and Existing Music Project 
 
Music プロジェクトを開くには： 
 
1.      をタップします。 

 
2. Project > Open をタップします。 SDカード上に、すべてのプロジェクトがリスト表示されます。

Music プロジェクトは、ミュージックノートアイコンで見分けることができます。 
 
3. HP エンコーダを操作してプロジェクトの１つをハイライト状態にします。エンコーダを押すとプ

ロジェクトを開きます。 
 
そのプロジェクトが開かれたら Home 画面が表示されます。これで録音スタートできます。 

 
Info: 現在のプロジェクトから他のプロジェクトに切り替えるとき、現在のプロジェクトを

save することに留意しなくても大丈夫です。 MixPre は現在のプロジェクト状態を自動
で save しています。 
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Home Screen for Music Projects 
 
Music プロジェクトがアクティブだと、Home スクリーンは Audio プロジェクトと異なるデザインをし
ています。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Info: 上のサンプル画像は,MixPre-3 の Home スクリーンです。Track Bank セレクター（白
い box）の中は３つのメーターがあります。Box の中のメーター数は MixPre-6 と
MixPre-10T とでは異なります。 

 
ここでは、Music と Audio プロジェクトがアクティブの時に、異なる部分を説明します。 
 
 

PROJECT NAME ICON DESCRIPTION 

Music Music Notes icon  Home 画面でこのアイコンにタッチして、Music Control

メニューにアクセスできます。 

Audio Audio File icon  

 

現在のミュージック・プロジェクトの名前が表示されます。 

Both Current file name  アクティブな Music project か audio file が表示されます。 

Both Time counter  Music project では、現在の位置を、hh:mm:ss:tenths で

表示。すべてのソングは 00:00:00:0.からスタートします。  

 

Audio project では、タイムコードカウンターを表示。 

Both Q icon  

 

 

現在のキューナンバーを、Q01, Q02.. と表示します。 

録音・再生中にタップすると、新しいキューポイントを追

加できます。停止中にタップすると、Cue Points メニュー

にアクセスできます。 
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PROJECT NAME ICON DESCRIPTION 

Music Meter Viwes  Music project がアクティブのとき、メータービューは１

つだけです。 12 トラックと LR ステレオのメーターが表

示されます。 

 

メーターをタップすると track banks を切替える事ができ

ます。 

Audio  Audio project がアクティブのとき、３つの異なるメータ

ーが表示され、タップするごとにサイクル切替することが

できます。 

Music Status bar  タッチによるサイクル・ステータス表示 

・ Song status: 現在のバーポジション、パンチ、メト

ロノーム、レンダリングステータス、リメインタイム

を表示。停止中か録音中は、リメインタイムフィール

ドは SD カードの残時間を表示。再生中は song の最

後までの時間を表示。 

・ USB drive status：ドライブ残容量の表示。 

・ Date & Time 

Audio  タッチによるサイクル・ステータス表示 

・ SD card status: カードアクセス、録音可能時間、フ

ァイルの長さ、経過時間、ヘッドフォンプリセット 

・ USB drive status: ドライブ残容量の表示。 

・ サンプルレートとビット深度 

・ Date and Time 

 
 

Music Control Menu 
 
Music Control メニューは、プロジェクトの History list、 Cue list, Render, Metronome 機能、
Solo/Mute スクリーンにアクセスできます。 
 
Music Control メニューにアクセスするには： 
 
➢    をタップします。 
 
 
 

Music Project History 
 
録音されるごとに、ヒストリーリストの中にアイテム（リビジョン）として記録されます。ここから、
前の録音テイクへ「アンドゥ」したり、後の録音へ「リドゥ」したりと、異なる複数テイクと比べたり、
悪いテイクをすばやくリドゥすることができます。ヒストリーリストは年代順に表示し、最も新しいレ
コーディングをトップに表示します。 
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ヒストリーリストで、前／後のレコーディングに切り替えるには： 
 
1. Home 画面の左上の     をタップします。 

 
2. History をタップします。 ヒストリーリストが表示されます。 

 
 
 
 
 
 
 
 
 
 
 

3. HP エンコーダを操作してリストの中のファイルをを１つ選択します。現在のレコーディングがア
スタリスクマーク（*）がファイルネームの右に表示されます。 

 
Info: リビジョンのファイルネームは録音完了の日付と時刻を元にしています。例えば、2018

年 3 月 12 日の 2:22PM(14:22)に録音完了したファイルは 001-031218-142200 と
なります。 

 
スクラッチから現在のプロジェクトをリスタートするには： 
 
ヒストリーリストから、一番下にスクロールし、Restart Song を選択します。 
 

Info: これはプロジェクトからすべてのオーディオをクリアし、もとに戻すことはできませ
ん。しかし、オーディオ・ファイルそれ自体が削除されることはありません。それら
はプロジェクト・フォルダに残っており、コンピュータからアクセスできます。 

 
 

Track Bank Selector 
 
フィジカルノブの数よりも Music project の中のトラック数（12tracks）のほうが多い（MixPre-3 は
ノブが３つ、MixPre-6 はノブが 4 つ、MixPre-10T はノブが 8 つ）ので、グループトラックを選択し
てからフロントのノブでコントロールするために、Track Bgank Selector が使用されます。 
 
Track Bank Selector は白い box で示され、選択されたトラックはこの box で示されます。 次のイメ
ージ画像は、MixPre-10T（左）、MixPre-6M（中）、MixPre-3M（右）です。 
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MixPre-3 で track banks を切替えるには： 
 
➢ メーターをタップして、各３つのメーターを 4 回サイクル切替します。 1-3, 4-6,7-9, 10-12 
 
MixPre-6 で track banks を切替えるには： 
 
➢ メーターをタップして、各 4 つのメーターを 3 回サイクル切替します。 1-4, 5-8, 9-12 
 
 
MixPre-10T で track banks を切替えるには： 
 
MixPre-10T では、フロントパネルの上部４つのノブは常に 1-4 をコントロールします。 
 
➢ メーターをタップして、下部の 4 つのノブ用に 5-8 か 9-12 を切替えます。 
 
Track bank が切換ると、新たに選択されたバンクでチャンネル・ノブを回しても、前にストアされた
位置まで回さないとノブのコントロールが反映されません。元の位置まで回すことで、ゲインが通常通
りノブの位置と一致してコントロールできるようになります。 
 

Info: Track banks を切替えて、ノブを回転させてフェーダーレベルの位置がノブと揃うまで、
リング LED はオレンジで点滅します。 ノブ位置とフェーダー位置が揃うとオレンジ点
滅が停止します。 

 
 
チャンネル・ノブ調整中のフェーダー値と、以前にストアされているフェーダー値がオレンジ色で
Home 画面（かチャンネル画面）の上部に表示されます。 ノブを調整して両方の値が一致したところ
で、数字の色が黒色に変わります。 
 
フェーダーレベル表示の例： 
 
この例では、フィジカルフェーダーの値が -18dB で、トラック 9 のチャンネル・ノブを時計回転方向
に調整しなければならないことを矢印が示します。以前にストアされている値、ここでは -15dB に達
すると、ミックスレベル調整できるようになります。 
 
 
 
 
 
 

Info: 以前にストアされたフェーダー値と矢印アイコン（オレンジ色）を表示させるためには、
チャンネル・ノブをごくわずか調整してください。情報が表示されることで、どちらの
向きへフェーダーを調整するべきかを判断できます。 
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Channel Screens for Music Projects 
 
チャンネル画面にアクセスするには： 
 
➢ アクセスしたいチャンネルのチャンネル・ノブを押します。 
 
 
 
 
 
 
 
 
 
 
各チャンネル画面には２つの設定用ページがあります。ページ位置はドット・アイコンで示され、ドッ
ト・アイコンにタッチしてページを切替えることができます。 
 

サブメニュー 情報先 

 Solo & Mute Using Solo/Mute 

 Arm Arming a Track 

 Input Setting Input Source 

Monitor Enabling Monitoring 

 Gain Setting the Gain 

 Pan Understanding Pan 

 Reverb & Air Using Reverb & Rendering a Vocal Air Effect 

 Low Cut Setting the Low Cut Filter 

 Phase Toggling Phase Inversion 

 Linking Stereo Track Linking 

 
 
 
 

Setting Input Source 
 
MixPre-3 は XLR mic/line 入力、3.5mm(Aux In)、USB ソースを入力できます。 MixPre-6、
MixPre-10T は XLR(と 1/4 インチコンボジャック)入力、3.5mm(Aux In)、USB ソースを入力できま
す。（Music Project では）どのフィジカル入力をどのトラックへも、チャンネルスクリーンから音声を
ルートすることができます。 
 
入力ソースとチャンネルの組み合わせは自由に設定できるので、オーディオ・ソースを異なるトラック
に録音したい時にケーブルを差し替える必要はありません。入力ソースに、MixPre-10M の出力
（Bouncing 章を参照）、メトロノームのクリック音（Metronome 章を参照）をアサインすることもで
きます。また、この画面からファンタム電源の On/Off も設定できます。 
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インプットへルーティングするには： 
 
1. チャンネル画面に入り、Input をタップします。次のサンプル画像のようなルーティング画面が表

示されます。 
 
 
 
 
 
 
 
 
 
 

2. トラックのソースを１つ、選択します。トラックにはライブ入力ソースを１つだけ設定できます。 
 

3. 必要に応じてファンタム電源を有効にします。[Phantom] は 48V 電圧の on/off です。もしコ
ンデンサー・マイクロフォンが接続されていれば、ファンタムをオンにしてください。 

 
Info: Phantom オプションは選択されたオーディオ・ソースによっては表示されません。 

 
4. メトロノームのクリック音を録音したい場合は、[Click] を有効にします。録音後のデータを DAW

にインポートして曲にオーバーダビングする場合に便利です。録音されたメトロノームを利用して
DAW のテンポを設定することで、MixPre レコーディングと完璧にそろえることができます。 

 
 

Tip: (10T のみ) 曲のアイディアをラフスクラッチとしてすばやく録音したい時にマイクロ
フォンが手元に無くて、音質を気にしないのであれば、MixPre 内蔵マイクを利用でき
ます。 Inputs > Aux In Mode で Internal Mic に設定し、ルーティング画面で Aux In
に設定してください。サンプル画像の Track4 ではインプットソースとして Internal 
Mic がアサインされています。（他のサンプル画像で、Aux In が Internal Mic となって
いない理由は、Aux In Mode の設定が異なるためです。） 

 
 
 
 

Enabling Monitors 
 
モニター機能は、再生中にライブ・インプット信号も聞くことができます。すでに録音されたトラック
と一緒に練習演奏したり、ライブパフォーマンスに利用したりと便利です。 
 
モニターを有効にするには： 
 
➢ チャンネル画面に入り、Monitor をタップします。 モニターOn のときボタンはオレンジ色で表示

されます。 
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Using Solo/Mute 
 
Music projects では、トラックのミュート、ソロをするためにいくつかの異なる方法があります。 
 
 各トラックのチャンネル画面で、Mute をタップして選択されたトラックをミュートできます。 ミ

ュートされたトラックの信号はミックスと出力に送られません。ミュートされると、ノブ周囲にあ
る LED リングが赤く点灯します。同時に複数のトラックをミュートにすることができます。 
 

 各トラックのチャンネル画面で、Solo をタップして選択されたトラック（プリフェード、プリエ
フェクト）の音をヘッドフォンでモニターできます。ソロになっているトラックは、LED リングが
オレンジに点灯します。 

 
複数のトラックをすばやくソロ／ミュートするには、Solo/Mute 画面が便利です。全 12 トラックのソ
ロとミュートをこの画面から操作、確認することができます。 
 
 
Solo/Mute 画面からソロまたはミュートするには： 
 

1.     をタップします。 Music Control 画面が表示されます。 
 

2. Solo/Mute をタップします。 Solo/Mute 画面が表示されます。 
 
 
 
 
 
 
 
 
 
 

3. 次のいずれかの操作を行います。 
 

➢ Solo か Mute のどちらかをタップし、任意のトラックを選択します。ソロになったチャンネル
はオレンジ色で、ミュートされたトラックは赤色で表示されます。 
 

➢ HP エンコーダを操作して任意のトラックをハイライト状態（緑色の枠）にしてから、Solo か
Mute をタップします。 

 
4.    をタップして、画面を終了します。 
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Using Reverb 
 
リバーブは、LR ミックスの中のトラックにどれだけリバーブ効果を与えるかを設定します。 ミックス
だけに効果があり、個々の録音されたトラックに効果はありません。 
 
個々の録音されたトラックへリバーブ効果をレンダーするには、バウンス機能を利用してください。 
 
リバーブを調整するには： 
 
➢ チャンネル画面から、Reverb をタップしてエンコーダで調整してください。 調整範囲は、Off, 

-50dB から 0dB まで 1dB ステップです。 
 
タイプ、ディケイ、プリディレイなどの異なるリバーブ・キャラクターを選択できます。 
 
リバーブを設定するには： 
 

1.     をタップします。 
 

2. サブメニューにページして、Reverb をタップします。 
 

3. 次の設定をタップして、値を変更してください。 
 

セッティング オプション 

Reverb Type Off, Plate, Hall, Room 

Reverb Decay 0.1 – 5.0 秒 

Reverb Pre-Delay 0 – 40 ms 

Reverb HF Damp Off, 0 - 20 

 
 

Rendering a Vocal Air Effect 
 
リードヴォーカルに Air エフェクトを適用すると、ミックスの中でヴォーカルが引き立ちます。 これに
よりヴォーカルに快活な艶が付加されます。 
 
ヴォーカル・エアは、LR ミックスの中のトラックにどれだけリバーブ効果を与えるかを設定します。 調
整範囲は、Off, 1% ～ 100%です。 ミックスだけに効果があり、個々の録音されたトラックに効果は
ありません。 
 
個々の録音されたトラックへ Air エフェクトをレンダーするには、バウンス機能を利用してください。 
 
 

Info: Air は一度に１つのトラックに適用されます。トラックに Air を適用したいのに、チャン
ネル画面で Air がグレイになって使えない時、すでに適用されている他のトラックの Air
を外してください。複数のヴォーカルトラックに Air を適用するには、バウンス機能を
利用してください。 
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Toggling Phase Inversion 
 
位相反転（または極性反転）は、間違って配線されたバランスケーブル、反対方向に向いて設置された
２つのマイクロフォン（ドラムキットのオーバーヘッドなど）、などのシグナル・キャンセレーション
を防ぐために用いられます。 
 
Phase 設定は、位相反転の On／Off です。 
 
チャンネルの位相を反転するには： 
 
➢ チャンネル画面から Phase をタップします。 
 
 
 

Punching In/Out 
 
パンチングは、アーム解除されたオーディオデータのあるトラックを再生しながら、アームされたトラ
ックの in と out の位置で録音状態にする機能です。 オートマチック・パンチングは一般的に使われる
テクニックで、オーディオが存在するトラックを再生しつつ、自動的に途切れなくあらかじめ決められ
たポイントで録音のドロップイン・アウトさせることができます。新しいトラックへ、または、すでに
オーディオが存在するトラック上にも、パンチイン・アウトできます。 
 
すでに素材が存在する上にパンチイン・アウト（オーバーダビングと呼ばれる）は、すでに録音された
トラックの音で、Record In と Out で指定された領域に新しくオーディオを置くことです。 
 
 
手動でパンチイン・アウトするには： 
 
1. パンチイン・アウトしたいトラックをアーム状態にします。 

 
2. 再生中に、任意のタイミングでパンチインするために REC を押します。 MixPre はアームされた

トラックに録音します。 REC コントロールは明るく赤色に点灯します。 
 

3. もう一度 REC を押すとパンチアウトします。MixPre は再生を続けながら録音だけ停止します。 
 
 
自動的にパンチイン・アウトするには： 
 
1. MixPre を自動的にパンチイン・アウトさせたいところに、Record In と Record Out ポイントを

設定します。 Record In か Out ポイントが設定されると、オートマチックパインチングが有効で
あることを示す ’P’ がステータス・バーに表示されます。 
 

2. 必要に応じて、pre-roll と post-roll を設定するために、Play In と Stop の Q-Points を使用し
ます。Pre-roll をセッティングすることで、すでに録音された演奏を Record In ポイントより手前
から再生することができるので、パンチイン用の演奏がリズミカルかつスピーディに行えます。お
好みに応じて、pre-roll と post-roll 中のモニターソースを Track ‘Monitor’ ボタンを使って、ト
ラック再生かライブインプットのどちらかに設定できます。 
 

3. REC を押します。 トランスポート・ジョイスティック LED が緑色に点灯し、MixPre は（設定さ
れていれば Play In ポイントから、そうでなければ現在のプレイバック・カーソル位置から）再生
を開始します。再生しつつ、Record In ポイントに達すると、MixPre はアームされたトラックで
自動的に録音開始し、ジョイスティック LED が赤色に点灯します。録音は、Record Out ポイント
までつづき、そのポイントで MixPre は再生状態に戻り、ジョイスティック LED が緑色に点灯しま
す。再生は、Stop ポイントに達すると停止します。 
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Working with Cue Points 
 
MixPre-10M は、任意の演奏開始ポイントやオートマチック・パンチ IN/OUT ポイントへ簡単にロケー
トするために Q ポイントを利用します。 
 
Q ポイントは異なるタイプがあります。 
 

アイコン タイプ 詳細 

 Play In 再生開始点の指定。一般的にパンチイン(Record In)前のプリロール

として使用されます。 

 Record In 自動的に録音開始点の指定。（パンチイン・アウト領域の開始点） 

 

 Record Out 自動的に録音終了点の指定。（パンチイン・アウト領域の終了点） 

 

 Stop 再生停止点の指定。 一般的にパンチアウト(Record Out)後のポス

トロールとして使用されます。 

 Cue mark 

(Q01, Q02,etc) 

キューマークは曲中で任意のポジションにマークでき、すばやく簡

単にロケートすることができます。例えば、コーラス開始点 Q ポイ

ントを設定し、このキューポイントにわかりやすい名前をつけるこ

ともできます。 

 
 
Q ポイントを追加するには： 
 
1. 停止中に、Q アイコン     をタップします。Home 画面にもどると、Q-Points メニュー画面が標

示されます。 
 
 
 
 
 
 
 
 
 
 

2. 追加したいキューポイントに相当するボタンをタップします。キューポイントの追加は、停止中、
ポーズ中、再生中のいずれも可能です。 
 
 
 
 
 
 
 
 
 
 
 

 
Info: Out ポイントを置いた後に In ポイントを置くことはできません。各タイプ（Play か

Record）の In か Out ポイントは 1 つ以上置くことはできません。 
 
また、Play In、Record In/Out、Stop ポイントを Q-List からキューマークを作成することができます。 
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Play In, Record In/Out, Stop ポイントとしてキューを設定するには： 
 
1. Q-List から、キューを１つ選択します。 
2. Set As をタップします。 
3. Play In, Record In, Record Out, Stop のいずれかをタップし、選択されたキューを変更します。 
 
 
 

Bouncing 
 
MixPre-10M は、多くのシチュエーションに対応できる最大 12 トラックのレコーダーです。例えば、
ドラム用に 4、ベース用に 1、ヴォーカル用に 2、ギター用に 2、キーボード用に 2 トラックを使用し
てもスペアに 1 トラック残ります。 
 
しかし、ときにはもっと多くのレイヤーが必要となるかもしれません。ピンポンと呼ばれるバウンシン
グ機能は、ビートルズやビーチボーイズなどが活躍した時代のテクニックで、オーバーダビング用の空
トラックを作るためにマルチトラックを１つか２つにコンバインすることです。これは、マルチトラッ
クをグルーピングすることでの単純なミックスダウン、あるいは ISO トラックにリバーブやエアーエフ
ェクトをかけることにも用いることができます。 
 
MixPre では、バウンス・ミックスは LR ミックス機能を利用しています。 
 
バウンスするには： 
 
1. バウンスしたいトラックを決めます。 これをディスティネーション・トラックと呼びます。 

 
2. ディスティネーション・トラックのチャンネル画面で、Input を MixL、MixR、または両方 に設定

します。 このチョイスは、バウンスしたいものがモノ、ステレオ、デュアルモノであるかで決ま
ります。例えば、track-1 と 2 にステレオバウンスする場合、track-1 を MixL に、track-2 を MixR
に設定します。もしも track-3 にモノラル・バウンスする場合は、track-3 を MixL と MixR の両方
に設定します。 

 
Info: MixL か MixR に設定されたトラックは、フィードバックを防ぐために LR mix から取り

除かれます。 録音されるバウンスのレベルを LR ゲインコントロールで調整することが
できます。 Home 画面の L(left)ミックスメーターをタップしてすばやく LR ゲインに
アクセスできます。 
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3. バウンス元のトラックを決めます。 これらをソース・トラックと呼びます。 

 
4. ソースとディスティネーション・トラック以外のすべてのトラックを Mute にします。 

 
5. ディスティネーション・トラック以外のすべてのトラックをアーム解除します。 

 
6. ソース・トラックの levels, pans, reverb, air effects を必要に応じて設定します。 エフェクトは

ディスティネーション・トラックに反映されます。 
 

7. これでバウンスの準備が整いました。 
 

8. 手動で録音開始するか、オート・パンチイン機能でバウンシングを開始します。 ノーマル録音と
なるので、リアルタイムにソース・トラックの levels, pans, effects を動的に調整することができ
ます。 
 

9. バウンスを止めたいときに Stop を押して停止できます。 
 

10. ディスティネーション・トラックから MixL と MixR の送りとアームを解除します。 
 

11. バウンスの結果を聴くには、バウンスがスタートされた場所から再生を開始します。ミックスレベ
ル、pan, reverb, air を調整してください。 

 
バウンス・トラックだけをモニターするには、オリジナルのソース・トラックを mute するか削除して
ください。 
 
 
 
トラックをクリアするには： 
 
1. チャンネル画面にアクセスします。 

 
2. Input をタップし、次に Clear をタップします。 

 
 
 
 
 
 
 
 
 
 
Clear コマンドは、トラックにオーディオデータがあるときだけ表示されます。 
 

 
Info: トラックをクリアするとプロジェクトから完全に取り除かれます。ファイルはまだ存在

していますが、コンピュータからでないとアクセスできません。 
 
3. Yes をタップして、プロジェクトからのトラック・オーディオ取外しを確認します。 
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Metronome 
 
メトロノームは、録音中に演奏を始めるタイミングをとるため、あるいは再生がいつ始まるかをカウン
トインで知らせる機能です。バーの最初のビートは他のビートよりも高いピッチで鳴ります。メトロノ
ームのクリック音は LR ミックスと合成され、ヘッドフォンや LR に設定された出力端子で聴くことが
できます。 
 
メトロノームの設定をするには： 
 
1.      をタップします。 

 
2. Metronome をタップし、必要な設定を行ってください。 
 
 
 
 
 
 
 
 
 
 

Info: 画面表示中は、メトロノームのプレビュー音を聴くことができます。 
 
➢ Sginature をタップして拍子を設定します。 

オプション： 1/4, 2/4, 3/4, 4/4, 5/4, 6/4, 7/4, 8/4, 6/8, 7/8, 9/8 
➢ Tempo をタップしてテンポ（クリック音のレート）を HP エンコーダで bpm (beats per minute)

値を設定します。 範囲は 40 ～ 240 bpm。 
➢ Volume をタップしてメトロノームの音量を調整します。 
➢ Count-in をタップして、録音開始前のカウント数を設定します。範囲は 0～8 bars。 
➢ On During…をタップしていつメトロノームがアクティブになるかを設定します。 

オプション： Record, Play, Count-in 
 

 
メトロノームを有効にするには： 
 
Music Control メニューからメトロノームボタン   をタップします。アクティブになると、メトロノー
ムのアイコンがオレンジ色で表示されます。 
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Info: トラックのインプット・ソースにクリック音がアサインされると、メトロノームボタンは
無効（グレイアウトでオレンジ色のアイコン表示）です。 

 
 

Record Settings 
 
Record サブメニューでは、次の表のように詳細な設定項目があります。 
 

サブメニュー 詳細 オプション 

L&R Gain LR ミックス用のゲイン設定 ・ -30 – 0 dB (1dB ステップ) 

 Info: Home 画面で L(left)水平メーターをタップすると、L&R ゲインにすばやくアクセ

スすることができます。 

AAC Quality AAC 用レンダリングの品質設定。 

 

・ 32 kbps 

・ 64 kps 

・ 128 kbps 

・ 192 kbps 

・ 256 kbps 

 
Record サブメニューにアクセスするには： 
 
➢     をタップしてから、Record をタップします。 
 
 
 

Sharing Projects 
 
シェアリング・プロジェクトは、簡単にコンピュータへ転送して、インターネットで仲間にアップロー
ドしたり、SD カードや USB サムドライブを手渡ししたりできます。 
 
プロジェクトを共有するにはいくつかの方法があります。 
 
 プロジェクト・フォルダのコピー： MixPre-10M ユーザー同士での受渡しに適します。SD カード

からプロジェクト全体をロードすることができ、プロジェクト作業を継続できます。 
 Wav か AAC ステレオファイルにレンダー： 友人やバンドメンバーに最終ミックスを渡すのに適

します。 
 

Info: AAC ファイルは、.mp3 オーディオ・ファイルのようなもので、同じビットレートで
あれば AAC のほうが良い品質を期待できます。 

 
 すべてのトラック（ISOs として録音された）をモノフォニック・ファイルとしてレンダー： DAW

にインポートしてプロダクション作業を続けるのに適します。 
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プロジェクトをレンダーするには： 
 
1.      をタップします。 

 
2. Render をタップします。 

 
 
 
 
 
 
 
 
 
 
 

3. レンダー後のファイル形式を設定します。 
オプション： Wav Stereo か AAC Stereo 

 
 Wav Stereo:  非圧縮の 2ch ステレオ wav ファイルに LR ミックスをリアルタイムにレンダーし

ます。 レンダリング中の、トラックレベル、パン、ミュート、リバーブ、エアーエフェクトのす
べての調整はステレオ wav ファイルに反映されます。 
 

 AAC Stereo:  圧縮された 2ch のステレオ AAC ファイルに LR ミックスをリアルタイムにレンダ
ーします。AAC ファイルは WAV ファイルと比べてかなり小さいサイズなので、インターネットで
共有するのに適します。 レンダリング中の、トラックレベル、パン、ミュート、リバーブ、エア
ーエフェクトのすべての調整は AAC ファイルに反映されます。 

 
Info: AAC 用のビットレートは、メイン menu の Record > AAC Quality の、 32, 64,128, 

192, 256 kbps から選択できます。数値が大きいほど、品質が良くなります。 
 
 Wav All Isos:  すべてのアイソレート・トラックをそれぞれモノフォニック・wav ファイルへリ

アルタイムにレンダーします。DAW にすべてのトラックをインポートするのに適します。 すべて
のファイルを DAW のタイムラインのゼロポジションにドラッグするだけで、トラック間のタイミ
ングが完璧に揃います。 
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MixPre-10T 
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MixPre Ambisonics Plugin 
 
 
 
ファームウェア V3.00 以上の MixPre-6 と MixPre-10T は、Ambisonics プラグインに対応（Sound 
Devices ストアから無償）し、Ambisonics 拡張とバイノーラル録音、再生、モニタリング機能が利用
できます。 
 
ゲーム、VR、bideo、効果音、ミュージック用などの 360° 空間音場を制作する上で、MixPre-6 と
-10T は、3D オーディオをキャプチャーするのに理想的なポータブルレコーダーです。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Ambisonics プラグインの特徴： 
 Sennheiser AMBEO VR マイク (Ambisonics A-Format) をサポート 
 Ambisonics A フォーマットと B フォーマット(FuMa と AmbiX) の録音・再生・モニター 
 A フォーマットから B フォーマットへコンバート 
 192kHz までのサンプルレートに対応 
 異なるマイク・オリエンテーションをサポート（Up, Down, Endfire） 
 Ambisonics、ステレオ、バイノーラルを WAV で同時録音 
 1 つのゲインノブでリンクされた 4 チャンネル・ゲインをコントロール 
 

Info: バイノーラルは 96kHz サンプルレート以上はサポートされません。 
 
Ambisonics マイクは、カーディオイドかスーパーカーディオイドのマイクロフォンカプセル４つが四
面体にアレンジされて構成されるマイクロフォンです。 これは、空間の 1 ポイントにおいて、音の完
全球面をキャプチャーすることができます。 この４つのカプセルによるアプローチは、ファースト・
オーダーAmbisonics として知られます。 あまり一般的ではありませんが、セコンド・オーダー
Ambisonics では、より多くカプセル数を使ってより正確な球面解像度を達成されます。 
 

Info: MixPre-6 と-10T は、ファースト・オーダーAmbisonics だけに対応します。 
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Ambisonics フォーマットには、A フォーマットと B フォーマットがあります。 
 
A フォーマットは、４つのマイクロフォン・カプセルをプロセスしない生音を直接送る方式です。 
 
B フォーマットは、球面音場空間を表すために最も広く使用されている方式です。 これは主に、3D 立
体音場を B フォーマットで録音することで、現在のものだけでなく将来のサラウンドフォーマットへ
のデコードを可能とするからです。 
 
他の Ambisonic マイクと同様に Sennheiser Ambeo マイクも、出力は A フォーマットです。 したが
って、サラウンド・ポストプロダクションを始める前に、B フォーマットへコンバートする必要があり
ます。 MixPre-6 と 10T には、A-to-B フォーマット・コンバータが内蔵されているため、DAW でそ
の処理を行う必要はありません。 Soundfield ST450 MKII のような一部のマイクは、直接 B フォー
マットを出力できるため、コンバートする必要はありません。 
 
B フォーマットは、4 チャンネルの W,X,Y,Z で表されます。 
 
 W = 全方向からの全信号の合計（無指向性マイクのような） 
 X = 全方向からのフロントマイナス（双指向性マイクに面して、水平 Front/Rear のような） 
 Y = Left マイナス Right （双指向性マイクに面して水平 Left/Right のような） 
 Z = Up マイナス Down （双指向性マイクに面して 垂直 Up/Down のような） 
 
また、B フォーマットには、 FuMa と AmbiX の２種類があります。 
本質的には、W,X,Y,Z チャンネルの並びが違いがあげられます。 
 FuMa = W,X,Y,Z 
 AmbiX = W,Y,Z,X 
 
MixPre はこの 2 種類に対応します。 もしどちらで録音するべきかわからない場合は、両方同時に録
音することができます。 
 
Ambeo のような 1 本の Ambisonics マイクロフォンで録音する時、4 チャンネルのゲインはまったく
同じ値であることが原則です。そうでなければキャプチャーされた音場は中心から外れてしまいます。 
Ambisonics モードを有効にすると、MixPre はチャンネル 1-4 をリンクします。 ノブ 1 を回して、4
つのチャンネルすべてのゲインが揃った状態でゲインを均等に調整できます。 
 
 
 

Installing and Activating the Plugin 
 
Sound Device オンラインストア (http://store.sounddevices.com) から無償で購入し、ダウンロー
ドできる、Ambisonics プラグインは、Ambisonics 録音用に必要です。 
 
 
プラグインをインストール、アクチベートするには： 
 
1. 無償で購入、ダウンロードした .LIC ファイルを、SD カードにコピーします。 
 

Info: Ambisonics プラグインは、MixPre-6 と -10T レコーダーのシリアル番号にラインセ
ンスされ、他のデバイスや複数の MixPre デバイスでの利用はできません。 

 
2. SD カードを MixPre に挿入し、レコーダーの電源を入れます。 
 

http://store.sounddevices.com/
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3.      をタップします。 

 
4. System > Plugins をタップします。 

 
5. Apply Plugins をタップすると、ライセンスがインストールされ、デバイスのリブート後にプラ

グインが有効化されます。 
 
 

Monitoring Ambisonics with Headphones 
 
 
Ambisonics をヘッドフォンでモニターするには、B フォーマットの 4 チャンネル（W,X,Y,Z）を 2 チ
ャンネル（人間は２つの耳しかないので）にデコードしなければなりません。 MixPre ではステレオか
バ イ ノ ー ラ ル へ デ コ ー ド す る こ と が で き ま す 。  ス テ レ オ は 標 準 2D 、 3D 音 場 を 表 す
Left/Center/Right を 提 供 し ま す 。  一 方 、 バ イ ノ ー ラ ル は 、 フ ル 3D 音 場 （ Left/Right, 
Forward/Back, Up/Down）をペアのヘッドフォンでモニターすることができます。 
 
3D 音場をバイノーラルでモニターする機能は、収録時に適切なマイク配置を確認するために有効で、
つまり、配置や向きのミスを低減できます。 
 
MixPre は、stereo / binaural の録音・再生機能も提供します。 
 
 
Ambisonics を設定するには： 
 
1. MixPre に Ambisonics プラグインがインストールされアクチベートされているか確認します。 

 
2. Sennheiser Ambeo マイクロフォンを MixPre-6 か -10T に接続します。 Ambeo の XLR ケー

ブルが正しい順序で接続されているかを確認します。 
 
黄色 XLR1 は MixPre XLR input 1 
赤色 XLR2 は MixPre XLR input 2 
青色 XLR3 は MixPre XLR input 3 
緑色 XLR4 は MixPre XLR input 4 
 

 
3. MixPreｇａ Advanced Mode または Custom Mode で Channel と Headphone が Advanced

に設定されていることを確認します。 
 

4. Ambisonics Mode を有効にします。 Menu > Ambisonics > Mode と進み、 任意のオプション
を選択します。 
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Ambisonics モードを有効にすると、Ch5-6 (MixPre-6) と 5-10 (MixPre-10T) は使用不可にな
り、Ch1-4 は自動的にリンクされます。 Ch1 のノブはこれら４つのチャンネルのマスターゲイン
となります。 
 
次の表は、さまざまな Ambisonics Mode についての解説です。 
 

 

AMBISONICS MODE DESCRIPTION 

Off Ambisonics Mode は無効です。 

A -> B (AmbiX) 入力される A フォーマットを、トラック 1-4 に録音するために AmbiX 

B フォーマット(W,Y,Z,X)にコンバートします。 

録音結果は、1 つの 4ch poly wav となります。 

A -> B (FuMa) 入力される A フォーマットを、トラック 1-4 に録音するために FuMa B

フォーマット(W,X,Y,Z)にコンバートします。 

録音結果は、1 つの 4ch poly wav となります。 

A -> B (AmbiX+FuMa) 入力される A フォーマットを、トラック 1-4 用の AmbiX B フォーマッ

ト(W,Y,Z,X)に、トラック 5-8 用の FuMa B フォーマット(W,X,Y,Z)に

コンバートします。Ch1 ノブは全 8 トラックへ送られるレベルをコン

トロールします。 

録音結果は、個々に 2 つの 4ch poly wav となります。 

A (Direct) 入力される A フォーマットを、プロセッシングすることなく直接トラ

ック1-4に録音します。ポストプロダクションでBフォーマットに変換

したい場合は、このオプションを使用します。 

録音結果は、1 つの 4ch poly wav となります。 

A (Direct) + (FuMa) 入力される A フォーマットを、プロセッシングすることなく直接トラ

ック 1-4 に録音し、トラック 5-8 に録音するために FuMa B フォーマ

ット(W,X,Y,Z)にコンバートします。 

録音結果は、個々に 2 つの 4ch poly wav となります。 

B (AmbiX) or B(FuMa) 入力される A フォーマットを、プロセッシングすることなく直接トラ

ック 1-4 に録音し、トラック 5-8 に録音するために AmbiX B フォーマ

ット(W,Y,Z,X)にコンバートします。 

録音結果は、個々に 2 つの 4ch poly wav となります。 

 
 

Info: Ambisonics Mode は Music Projects では利用できません。 
 
5. Ambisonics モードの、 Menu > Inputs > Ambisonics > Mic Position で、マイクの物理的向き

に合うように、設定オプションを選択してください。 
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オプションは、Up, Down, Endfire の３つです。 オプションを正しく設定しないと、音場が正し
くマッピングされないので注意してください。 
 

6. チャンネル画面 1 で、ファンタム 48V を設定します。 
 

7. チャンネルフェーダー1 を操作して、適正な信号レベルに調整します。 
 

8. HP Preset （メイン画面左上）で、LR Stereo か Binaural に設定すると、設定に応じてデコー
ドされた Ambisonics 信号をヘッドフォンでモニターすることができます。 
 

9. 録音するには、チャンネル画面 1 に入って Arm をタップし、REC ボタンを操作します。 
 
 
 

Recording 
 
MixPre は、Ambisonics A フォーマット、B フォーマット、ステレオ、バイノーラル wav ファイルの
さまざまな組み合わせで同時録音することができます。 この強力な機能により、制作ニーズに応じて
複数のフォーマットを容易に提供することができます。 
 

Info: 同時に録音されたファイルは、同じタイムコードスタンプとメタデータを持ち、iXML 
File Set Index を使用した系譜として関連付けられています。  
Tip: Wave Agent を使用してこのメタデータを閲覧することができます。 

 
 
どこにファイルが記録されるかは、３つに依存します。 
 
⚫ MixPre モデル 

MixPre-6 は最大 8 トラック録音できるので、1 式の 4ch Ambisonics wav ファイルと 1 式の
stereo wav ファイルと 1 式の binaural wav ファイル を記録することができます。 
MixPre-10T は最大 12 トラック録音できるので、2 式の 4ch Ambisonics wav ファイルと 1 式の
stereo wav ファイルと 1 式の binaural wav ファイル を記録することができます。 
 

⚫ Ambisonics モード 
このモードで、どのタイプの Ambisonics フォーマットが録音されるか、4ch wav を 1 式か 2 式
で録音されるか、を設定できます。 
 

⚫ Rec L,R と Rec Binaural の On/Off 設定 
Record メニューでそれぞれの On/Off を設定でき、stereo と／か binaural 2ch wav ファイルの
録音設定です。 

 
それぞれのファイルタイプは、ファイルネームの末尾で判断できます。例えば： 
 

AMBEO-001_A_FMT.wav  (A-format) 
AMBEO-001_FUMA.wav  (FuMa B-format) 
AMBEO-001_AMBIX.wav  (AmbiX B-format) 
AMBEO-001_LR.wav  (Decoded stereo) 
AMBEO-001_BIN.wav (Decoded binaural) 
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Appendix A 
 
 
 
 

Basic/Advanced Mode Differences 
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System Settings 
 
 

ページ サブメニュー 詳細 

１  Mode オペレーティングモード (Basic, Advanced, Custom) の切替 

1 File Transfer MixPre とホストコンピュータ間のファイル転送 

１  Limiters リミッターの on/off。（Advanced か Custom モードのみ有効） 

２  Bluetooth Bluetooth Smart on/off 切替 

２  Wingman Paasowrd Wingmann app で MixPre-10T と通信するときにパスワードを要求

するように設定 

２  Brightness タッチ画面とリング LED の輝度を個々に調整 

２  Version 製品のシリアル番号と現在のファームウェアバージョン 

３  Regulatory MixPre-10T に関する FCC コンプライアンス情報。 

(FCC ID: 2AKLX-739M10T and IC: 22225-739M10T) 

３  Date / Time 日付と時刻の調整、表示形式の設定 

３  Update Firmware SD カード上のファイルから MixPre のファームウェアをアップデー

ト。最新のバージョンはウェブページからダウンロードできます。 

www.sounddevices.com/support/downloads 

 

３  Tune Crystal 外部 word clock や LTC 信号に対して MixPre-10T の内部クリスタル

周波数をファインチューン 

 
 
 

http://www.sounddevices.com/support/downloads
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Specifications 
 
 
 

Audio Inputs 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

User’s Guide   

 

 

98   

 

 
 

Audio Outputs 
 
 
 
 
 
 
 
 
 
 
 

Recorder 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

USB 
 
 
 
 
 
 
 
 
 
 

Touch Screen 
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Timecode 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Remote Control 
 
 
 
 
 
 
 
 
 
 

Power 
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Environmental 
 
 
 
 
 
 
 
 

Dimensions and Weight 
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Software License 
 
 
End-user license agreement for Sound Devices MixPre Series Software / Embedded Firmware 
 
Important Read carefully:  
This Sound Devices, LLC end-user license agreement (“EULA”) is a legal agreement between 
you (either an individual or a single entity) and Sound Devices, LLC for the Sound Devices, LLC 
software product identified above, which includes computer software, embedded firmware, and 
may include associated media, printed materials, and “online” or electronic documentation 
(“SOFTWARE PRODUCT”). By using, installing, or copying the SOFTWARE PRODUCT, you agree 
to be bound by the terms of this EULA. If you do not agree to the terms of this EULA, do not use 
or install the SOFTWARE PRODUCT. 
 
 
Software Product License  
The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties, 
as well as other intellectual property laws and treaties. The SOFTWARE PRODUCT is licensed, 
not sold.  
Grant of license. This EULA grants you the following limited, non-exclusive rights:  In  
consideration  of payment of the licensee fee, Sound Devices, LLC, as licensor, grants to you, 
the licensee, a non-exclusive right to use this copy of a Sound Devices, LLC software program 
(hereinafter the “SOFTWARE”) on a single product and/or computer. All rights not expressly 
granted to licensee are reserved to Sound Devices, LLC. Software ownership. As the licensee, 
you own the hardware on which the SOFTWARE is recorded or fixed. Sound Devices, LLC shall 
retain full and complete title to the SOFTWARE and all subsequent copies of the SOFTWARE, 
regardless of the media or form on or in which the original copies may exist. The license is not 
a sale of the original SOFTWARE. 
 
 
Copyright 
All rights, title, and copyrights in and to the SOFTWARE PRODUCT (including, but not limited to, 
any images, photographs, animations, video, audio, music, text, and “applets” incorporated into 
the SOFTWARE PRODUCT) and any copies of the SOFTWARE PRODUCT are owned by Sound 
Devices, LLC or its suppliers. The SOFTWARE PRODUCT is protected by copyright laws and 
international treaty provisions. Therefore, you must treat the SOFTWARE PRODUCT like any 
other copyrighted material, except that you may make copies as only provided below. You may 
not copy the printed materials accompanying the SOFTWARE PRODUCT. Restrictions on use. 
Licensee may not distribute copies of the SOFTWARE or accompanying materials to others. 
Licensee may not modify, adapt, translate, reverse engineer, decompile, disassemble, or create 
derivative works based on the SOFTWARE or its accompanying printed or written materials. 
Transfer restrictions. Licensee shall not assign, rent, lease, sell, sublicense, or otherwise 
transfer the SOFTWARE to another party without prior written consent of Sound Devices, LLC. 
Any party authorized by Sound Devices, LLC to receive the SOFTWARE must agree to be bound 
by the terms and conditions of this agreement. 
 
 
Termination 
Without prejudice to any other rights, Sound Devices, LLC may terminate this EULA if you fail to 
comply with the terms and conditions of this EULA. In such event, you must destroy all copies 
of the SOFTWARE PRODUCT and all of its component parts. 
 
 
 



 

User’s Guide   

 

 

102   

 

 
Limited Warranty  
No warranties. Sound Devices, LLC expressly disclaims any warranty for the SOFTWARE 
PRODUCT. The SOFTWARE PRODUCT and any related documentation is provided “as is” without 
warranty or condition of any kind, either express or implied, including, without limitation, the 
implied warranties and conditions of merchantability, fitness for a particular purpose, or 
non-infringement. The entire risk arising out of use or performance of the SOFTWARE PRODUCT 
remains with you. No liability for damages. In no event shall Sound Devices, LLC or its suppliers 
be liable for any damages whatsoever (including, without limitation, damages for loss of 
business profits, business interruption, loss of business information, or any other pecuniary 
loss) arising out of the use of or inability to use this Sound Devices, LLC product, even if Sound 
Devices, LLC has been advised of the possibility of such damages. In any case, Sound Devices, 
LLC’s entire liability under any provision of this evaluation license shall be limited to the greater 
of the amount actually paid by you for the SOFTWARE PRODUCT or U.S. $5.00. Because some 
states/jurisdictions do not allow the exclusion or limitation of liability for consequential or 
incidental damages, the above limitation may not apply to you. 
 
Governing Law  
This agreement and limited warranty are governed by the laws of the state of Wisconsin. 
 
 
 
 
 
This device complies with part 15 of the FCC Rules. Operation is subject to the following two 
conditions: (1) This device may not cause harmful interference, and (2) this device must accept 
any interference received, including interference that may cause undesired operation. FCC Part 
15.19 (a) (3)  
 
Changes or modifications not expressly approved by the party responsible for compliance could 
void the user’s authority to operate the equipment. 
 
FCC Interference Statement 
 
This equipment has been tested and found to comply with the limits for a Class B digital device, 
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses and 
can radiate radio frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If this equipment does 
cause harmful interference to radio or television reception, which can be determined by turning 
the equipment off and on, the user is encouraged to try to correct the interference by one or 
more of the following measures: 
 
➢ Reorient or relocate the receiving antenna. 
➢ Increase the separation between the equipment and receiver. 
➢ Connect the equipment into an outlet on a circuit different from that to which the receiver 

is connected. 
➢ Consult the dealer or an experienced radio/TV technician for help. 
 
This device complies with FCC and ISED RF Exposure SAR limits exposure limits for general 
population / uncontrolled exposure. 
 
This Device complies with Industry Canada License-exempt RSS standard(s). Operation is 
subject to the following two conditions: 1) this device may not cause interference, and 2) this 
device must accept any interference, including interference that may cause undesired operation 
of the device. 
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